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Introduction
This User’s Guide explains how to use ECD’s (Electronic Controls Design Inc.)
WaveRIDER Wave Solder machine analyzer.
You do not need to be a computer expert to use this manual or the WaveRIDER
software.
The manual assumes you are familiar with Microsoft Windows.
The hardware portions of this manual are written to reflect SuperM.O.L.E. Gold
firmware versions 9.08 and higher. The software portions reflect versions 5.22
and higher.
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 Terms used in this Manual
ECD. introduced the original M.O.L.E. (Multichannel Occurrent Logger Evaluator) in
1986. Over the years ECD has produced several models of the M.O.L.E. for use in a
wide variety of applications. In this manual, we may refer to the SuperM.O.L.E. Gold
data recording device as the M.O.L.E..
•

Informs the user that the note includes important information.

•

Informs the user that the note includes a handy tip.
The following statements describe special terms that will be used in this manual.
Hardware Terms:
•

Informs the user that the note identifies conditions or practices that
could result in damage to the equipment.

•

Informs the user that the note identifies conditions or practices that
could result in personal injury or damage to property other than the
equipment.

•

WARNING – Surfaces may be Hot!

•

SuperM.O.L.E. Gold, may be referred as the M.O.L.E..

•

WaveRIDER Ready refers to the M.O.L.E. being configured to collect wave solder
data when used with the WaveRIDER kit.

•

Thermocouple, may be referred to as T/C.

Software Terms:
•

WaveRIDER SPC software may be referred to as WR SPC.

•

Workbook, contains all of the worksheets and the uploaded data set saved with file
extension (.MWR).

•

Worksheet, the individual pages or sheets in the workbook file.

•

Data Set, multiple data runs uploaded into the workbook file.

•

Data Run / Experiment, the data uploaded from the M.O.L.E..

WaveRIDER
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 Fonts Used in this Manual
This manual uses a special font to indicate terms or words that can be found directly on
the PC display.
For Example: Select the Open Workbook command from the File menu to open a new
workbook file. This font indicates the words Open Workbook and File are actually found
in the PC display.
 Computer Hardware Requirements
CPU, RAM, Hardware:

300mhz processor or equivalent
128 megabytes of RAM (minimum).
50 megabytes of free disk space.

Operating System:

Windows XP & 2000.

Disk Drive:

CD Rom drive.

Mouse:

Windows compatible mouse.

Communication Port:

Serial Port, USB (with port replicator).

Video:

Color VGA or better video card and appropriate video
monitor. (SVGA is highly recommended)

It is recommended that the minimum computer display area be set to 800 x 600.
For best performance set the display to 1024 X 768 (Refer to your Microsoft
Windows documentation for details).
Printer:
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Color printer is recommended.
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Operators Safety Information
The safety information in this summary is for the benefit of operating personnel.
Warnings and Cautions will also be found throughout the manual where they apply.

•

Hardware changes or modifications to the components are not expressly
approved by ECD could void the product’s warranty.

For protection of the kit components, observe the following:
•

Do not subject the components to sharp impacts.

•

Do not expose the components to corrosive environments.

•

Do not expose the RIDER, above the specified maximum temperature.

The warranty will not cover damage caused by neglect or abuse of this product.
To maintain the safety features incorporated in this product, operation must be in
strict compliance with the requirements specified herein.

WaveRIDER
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1.0 System Description
The main WaveRIDER hardware component is called the RIDER. The RIDER is a
solder machine data collection pallet with ECD’s SuperM.O.L.E. Gold at the heart of it.
When the M.O.L.E. is connected to the RIDER it takes on a special WaveRIDER
configuration for proper data interpretation. While riding on the solder machine,
conveyor data from the solder machine is collected by the RIDER and stored in the
internal memory of the M.O.L.E. After the RIDER has completed the data collection, it is
then connected to a PC and the data is uploaded into the WR SPC software for
analysis.
RIDER
PC

1
2
3

COUPON TEMP.
SENSORS

M.O.L.E.

4
5
6

A B C
DISTANCE/TIME SENSORS

Figure 1- 1: System Block Diagram
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1.1 Rider Description
This section covers brief descriptions for the external and internal features of
WaveRIDER.
External features:
•

Barrier box: This is the thermal protective barrier for the M.O.L.E..

•

Barrier locking latch: This latch secures the cover of the barrier to prevent it
from opening.

•

Coupon: Sensors that record temperature data from the solder machine. (Refer
to section 1.2 Coupon Description for more information).
BARRIER BOX
COUPON

COVER LATCH

Figure 1- 2: WaveRIDER

♦2♦

WaveRIDER

Internal Features:
•

Connector bridge: This is where the M.O.L.E. plugs into the WaveRIDER so it
can collect data from the RIDER sensors.

•

Extractor handle: This handle assists in the removal of the M.O.L.E..

•

Configuration plug: This plug configures the M.O.L.E. to operate in
“WaveRIDER” mode.

CONNECTOR BRIDGE

EXTRACTOR HANDLE

CONFIGURATION PLUG
Figure 1- 3: WaveRIDER Internal Features
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1.2 Coupon Description
Temperature data about a solder machine is taken from three type "K" thermocouples
(T/C) attached to the Coupon. Their purpose is to sense the impact of a solder machine
setup on circuit board "like" material, as opposed to the RIDER pallet material.
THREE TYPE “K”
THERMOCOUPLES

“TOP FOIL” T/C
COUPON

“SOLDER” T/C
“BOTTOM FOIL” T/C

Figure 1- 4: Coupon Description

The "Bottom Foil" T/C is inserted into the coupon as close to the bottom surface as
possible without breaking through. The "Solder" T/C is exposed below the bottom
surface of the coupon so it will contact the solder. The "Top Foil" T/C is inserted into the
coupon near the top surface.

“BOTTOM FOIL”
THERMOCOUPLE

“SOLDER”
THERMOCOUPLE

“TOP FOIL”
THERMOCOUPLE

Figure 1- 5: Coupon Cross section
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1.3 Software Description
This section presents an overview of a workbook management window. When the
software is started, it will automatically load the previously saved workbook file.
The first time the software is started a sample file (i.e. WRSample.mwr) will be
opened for users to familiarize themselves with the program. It is recommended
when the user starts collecting process data, a new or existing workbook should
be used.
1.3.1 WR SPC Workbook Features
The workbook has several features as described in the following section.
TITLE BAR
MENUS
TOOLBAR

VERTICAL SCROLL BAR

WORKSHEET TAB
SCROLL ARROWS

SPLIT BAR

HORIZONTAL
SCROLL BAR

STATUS BAR
WORKSHEET TABS
Figure 1- 6: Workbook Features
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•

Title Bar: This bar contains the program name, version, and the active workbook
file name.

•

Menus: These menus contain the commands and tools for each worksheet.
Each worksheet may contain different commands that supply specific support for
each worksheet. Individual worksheet menus are described in detail in their
specified sections of this manual.

•

Toolbar: The Toolbar has buttons to serve as shortcuts to the menu commands.
Individual worksheet toolbar buttons are described in detail in their specified
sections of this manual. Each worksheet may have different items on the toolbar
because of the different features offered by each worksheet.

•

Worksheet Tabs: These tabs are used to gain access to each worksheet.

•

Tab Scroll Arrows: These arrows are used to view other worksheet tabs if the
Horizontal scroll bar is covering them.

•

Split-bar: This bar slides the Horizontal Scroll bar to the left or right so all or part
of the worksheet tabs can be viewed.

•

Status Bar: This bar on the bottom of the worksheet display, shows the
available Help information, mouse pointer X-Y position, current date and time.

•

Horizontal Scroll Bar: This bar scrolls the worksheet display horizontally left
and right.

•

Vertical Scroll Bar: This bar scrolls the worksheet display vertically up and
down.
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1.4 Standard WR SPC Worksheet functions
1.4.1 Worksheet tabs
There are six standard worksheets and up to nine optional SPC sheets. These tabs are
located on the bottom left of the display.

Figure 1- 7: Worksheet Tabs

1.4.2 Selecting Worksheets
To a view worksheet, use the mouse pointer to click on a worksheet tab. The worksheet
tab will then become highlighted, and the worksheet will now be visible.
The keyboard does not allow access to the worksheets. The only way to select
the worksheet is by using the mouse pointer.

Figure 1- 8: Selecting a Worksheet

1.4.3 Split-bar
The Split-bar on the tab bar lets the user slide the Horizontal scroll bar to the left or
right, so all of the worksheet tabs can be viewed. This feature is located on the left edge
of the Horizontal scroll bar.
1.4.4 Worksheet Tab Scroll Arrows
Worksheet tabs may be hidden behind the horizontal scroll bar. To view them, the user
can either use the Tab Scroll Arrows located on the left of the worksheet tabs, or use
the Split-bar.

WaveRIDER
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1.4.5 Scrollbars
The worksheets have both Horizontal and Vertical screen scroll bars so the non-visible
areas of the worksheet can be scrolled into view. The Horizontal scroll bar is located in
the lower right corner and can be scrolled left or right by pressing the left or right arrows
located on each end of the scroll bar. The user may also scroll the display by sliding the
center scroll bar left or right. The Vertical scroll bar located on the right side of the
screen has the same features as the Horizontal scrollbar except it scrolls the worksheet
display up and down.

CLICK HERE TO SCROLL WORKSHEET TABS
CLICK AND DRAG TO VIEW
WORKSHEET TABS

CLICK TO
SINGLE STEP
WORKSHEET
VIEW LEFT OR
RIGHT

CLICK AND DRAG TO SLIDE THE
VIEW HORIZONTALLY
Figure 1- 9: Worksheet Options

It is recommended that the minimum PC display area be set to 800 x 600. For best
performance set the display to 1024 X 768 (Refer to your Microsoft Windows
documentation for details).
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2.0 Setup
This section provides the necessary information to setup M.O.L.E. components for data
collection.
2.1 Charging the Power Pack Battery
Because the M.O.L.E. is powered by a rechargeable Power Pack battery, it is important
that it is charged and operating properly prior to performing every experiment. A spare
Power Pack battery may be ordered so the one battery is charging while the other one
is being used.
Charging:
1) Remove the Power Pack battery by separating from the unit.

Figure 2- 1: Removing the Power Pack Battery
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2) Plug the transformer end of the charger into a (60Hz 120VAC, in North America)
or (230VAC) wall outlet and the connector end into the Power Pack.

POWER PACK BATTERY

POWER PACK CHARGER

Figure 2- 2: Power Pack Charger

A completely discharged Power Pack takes about 14 hours to be fully charged.
3) When the charging cycle is complete, connect the Power Pack to the M.O.L.E..
When the Power Pack is first connected, the LED will flash once to indicate that
the M.O.L.E. is ready to collect data. If the LED flashes more than once, a
complete reset has occurred and the M.O.L.E. will need to be re-configured.
(Refer to the software manual for detailed configuration information).
The Power Pack battery can be charged continously whenever the M.O.L.E. is not
being used, however, if the M.O.L.E. is going to sit idle for five days or more, you
may want to remove it from the charger.
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2.2 Software Installation
1) Insert the CD in the drive.
2) Select Run from the Start menu.
3) Select the Browse command button and navigate to the software CD. Doubleclick the installation .EXE file.
4) Select the OK command button to start the installation.

Figure 2- 3: Run Dialog Box

5) Closely follow the setup instructions provided with the software.
2.2.1 Starting the Software
Prior to starting, click the README icon from the WaveRIDER sub-menu in the
documentation program menu to read the latest release notes
After the software is installed, start the software program by double-clicking the
WaveRIDER SPC icon from the desktop.

Figure 2- 4: Program Icon

Once the software installation is complete, it is important to start the software
and configure the software to communicate with the M.O.L.E. (refer to section 2.3
Communications Setup).

WaveRIDER
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2.3 Communications Setup
1) Locate the PC Interface cable and plug the 9-pin connector into a PC COM port
and the other end into the M.O.L.E. Data Port.
If no Serial port exists, use the included USB adaptor to connect the interface
cable to the computer.

COMPUTER
REAR PANEL
RS232 COM PORT
PC INTERFACE CABLE

M.O.L.E.

DATA PORT

Figure 2- 5: PC to M.O.L.E. Connection

2) After the Computer interface cable is connected to a computer and Station, the
Communication (COM) port must be configured in the software to match the
same COM port as the oven computer so they can communicate.
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3) Start the software program by either double-clicking the WaveRIDER SPC icon
or selecting it from the program sub-menu.

Figure 2- 6: Program Icon

4) Once the software is running, select the Admin worksheet tab.

ADMIN WORKSHEET TAB
Figure 2- 7: Admin Worksheet

WaveRIDER
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5) Select the Configuration command from the File menu on the Admin worksheet
and the Configuration dialog box appears.
CONFIGURATION
COMMAND

Figure 2- 8: Configuration Command
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6) Click the Auto command button to have the software automatically find the COM
port the M.O.L.E. is connected. If the M.O.L.E. is not detected, there is a
communication problem (Refer to section 6.0 Service and Calibration for help).

Figure 2- 9: Port Configuration Dialog Box

7) Click the OK command button to finish.

WaveRIDER
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2.4 M.O.L.E. Installation
When inserting the M.O.L.E. into the WaveRIDER, make sure it is properly connected
to the RIDER thermocouple bridge and the configuration plug is secure.

CONNECTOR BRIDGE
EXTRACTOR HANDLE

M.O.L.E.
CONFIGURATION PLUG

Figure 2- 10: M.O.L.E. Installation

To remove, pull the extractor handle up and slide the M.O.L.E. away from the connector
bridge.
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3.0 Operation
The following section will guide the user through a typical data collection process.
These steps may vary depending on the process your company uses.
Prior to data collection, the M.O.L.E. must be “WaveRIDER Ready” as indicated
by a “WaveRIDER Ready” or “Xpert” sticker on the front of the M.O.L.E..
3.1 Data Collection
1) To start collecting data, the width of the conveyor must be set to match the width
of the RIDER.
2) Set the solder wave, pre-heat temperatures and conveyor speed, as a common
product would be processed.
If the Wave solder machine has an in-line conveyor washer, it must be turned
“OFF” or the RIDER must be removed before it reaches the washer. Washing the
RIDER with the M.O.L.E. installed may cause damage.

WaveRIDER
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3) Open the barrier box and make sure the configuration plug is in place and the
M.O.L.E. is connected to the Connector Bridge.
4) Press the start/stop button once to start the M.O.L.E.. When the M.O.L.E. turns
“ON” the activity light will flash and then illuminate and stay constant for the
duration of the run.
5) Close the barrier box cover and latch securely.

Figure 3- 1: Starting the M.O.L.E.
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6) Place the RIDER on to the Wave solder machine conveyor. Make sure the
RIDER is being fed into the machine in the proper direction. There are two
arrows on the RIDER barrier that indicates the proper direction. If a manual feed
wave solder machine is being used, hold the RIDER until the conveyor fingers
have completely grabbed the RIDER.

CONVEYOR

DIRECTION
ARROW

Figure 3- 2: Proper RIDER Loading

WaveRIDER
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7) Retrieve the RIDER when it has traveled completely through the wave solder
machine. The bottom of the RIDER will be HOT so using protective gloves,
retrieve the RIDER from the conveyor. The best way to handle the RIDER when
retrieving from the solder machine is to place one hand under the RIDER and
use the other hand to grab the barrier box cover.
8) Now that the data collection is complete, it is important to open the barrier box
cover to prevent the internal temperature of the M.O.L.E. to rise above operating
temperature specification. To turn the M.O.L.E. “OFF”, press and HOLD the
Start/Stop button until the M.O.L.E. indicator light turns off, then release the
button.
9) Remove the M.O.L.E. from the barrier by removing the configuration plug and
pulling the extractor handle up. Allow the RIDER and M.O.L.E. cool to room
temperature before collecting data again.

EXTRACTOR HANDLE

M.O.L.E.
CONFIGURATION PLUG

Figure 3- 3: Removing the M.O.L.E.
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Data Collection Tips:
• When turning the WaveRIDER “OFF” after the data collection process is
complete, do not release the button until the light goes off. Pressing the
Start/Stop button briefly will restart the data collection process and erase all the
data in memory.
•

The WaveRIDER continues to capture data until its memory is full or until it is
turned “OFF". It is recommended to turn RIDER “ON” after it is placed on the
wave solder machine conveyor, then turn it “OFF” as soon as possible after it
exits the solder machine.

•

If the production process uses pallets, the WaveRIDER sensors may not come in
contact with the solder wave. If this condition occurs, try the following options:

a) Install the RIDER into one of the pallets, which can adjust to fit the RIDER.
b) Raise the solder wave(s) height. (This does not represent actual machine use so
this option should be avoided).

WaveRIDER
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3.2 Transferring Data
When the data collection process is complete, data can then be analyzed using the WR
SPC software.
To read WaveRIDER data:
1) Connect the M.O.L.E. to the PC (refer to section 2.3 Communications Setup for
more information).
2) Start the software and select the Read WaveRIDER Data command from the
WaveRIDER menu. A status bar dialog box appears indicating that data retrieval
from the M.O.L.E. has begun.

Figure 3- 4: Read WaveRIDER Dialog Box

Once data transfer is complete, the dialog box will disappear and will return to the
current worksheet.
If the WaveRIDER has not collected enough data to create a complete profile a
message box appears.

Figure 3- 5: Communication Error Dialog box
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3.3 Expert Matrix
If the WaveRIDER has detected a problem during the data collection process, the
Expert Matrix is designed to guide the Operator (Expert) to trouble-shoot potential
causes that may have been discovered while interpreting the data printout. The kit
includes an Expert Matrix to be used in conjunction with the WaveRIDER Data
worksheet in the software to help diagnose and correct soldering problems caused by
solder machine setup or malfunction.
There are three main areas on the expert guide:
Problem (1): This column is used to indicate the wave solder machine problem.
Potential Cause (2): This is a list of potential machine causes.
WaveRIDER Parameter (3): This column is a list of information the WaveRIDER
supplies on the printout that correlates to the potential
cause.
The numbers assigned to the Potential Causes are on a scale of 1-3. (1) Low impact on
that particular cause and (3) would mean that it has a High impact.

WaveRIDER
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WaveRIDER Parameter (3)

Problem (1)
Solder Skips
Solder Bridges
Unfiltered Via Holes
Solder Wave Over Flooding Board
Grainy or Disturbed Joints
Cold Solder Joints
Solder Balls on Assembly
Cracked Components

Potential Cause (2)

Maximum Preheat Temp.
Minimum Preheat Temperature
Maximum Preheat Slope
Conveyor Speed
Delta Temp at Chip Wave
Chip Wave Temp
Chip Wave Dwell Times (A, B, C)
Chip Wave Contact Lengths (A, B, C)
Chip Wave Immersion Depth
Chip Wave Parallelism
Delta Temp at Solder Wave
Solder Wave Temp
Solder Wave Dwell Times (A, B, C)
Solder Wave Contact Lengths (A, B, C)
Solder Wave Immersion Depth
Solder Wave Parallelism
A36-9283-06 Rev 1.2

1
3 2 3
2 2
3 3 3 3 2
2 2 1
3 3
2 2 3 1 1 1

2

3

2
1

3 3

2

1
3

1
3

3

1

3 2 3 3

1

1

2
3

3

3
1

3
1

3

1

1

3

3

2

3

3

3

3

3

2

3

2
1

2
1

2

1

3 3

3

3

2
1

2
1
2

3
3
3
3

3 3

3
3
3
3

3

3
3
3

3
3

3

3 3
3

3 2
3
3
2

3 3
3 3
3 3

3
3

3

2
1
1

2
2
1

3
2

1
1

1

3
3
2

1

3
2

1

1

Conveyor speed too fast….Reduces dwell time in wave and forces preheat to be to high
Preheat temp low….Solder pads not within 100°F of solder wave temperature
Conveyor speed too low….increases dwell time in solder wave
Carrier bent or damaged….Board must run parallel (flat) over wave
Conveyor fingers bent….Board may not be parallel over solder wave
Vibrator, 2nd wave OFF….Solder is not evenly distributed
Flux applied is insufficient….Spotty application or weak activity flux
Rails not parallel (flat) over nozzles….One side of board deeper in solder wave than the other
Wave or nozzles not level….Must be parallel to conveyor
Wave temperature too high….Solder and components are getting cooked
Conveyor width too tight….May warp board up or down while in wave
Preheat too high….Heating slope is too steep
Assembly too heavy….Weight or components bending board
Board too wide….Wide boards lack strength to support their weight
Conveyor jerky or vibrating….Disturbs solder joints while cooling
Flux not uniform across bottom of board….Spotty application of flux
Preheat slope too steep….Heats components faster than recommended
Chip wave OFF….Solder is not evenly distributed
Chip wave activity too low….Solder is not evenly distributed
Wave height/exit incorrectly set….Exit speed of solder should match conveyor speed
Wave solder splash….Too active wave splashes solder on exit
Assembly removed too early….Solder not hardened before distributed
Carrier too tight….May warp board up or down while in wave
Conveyor too low….Boards below wave
Chip nozzle clogged….Solder is not evenly distributed
Vibrator, 2nd wave too low
Wave height too high….Wave height greater than thickness of board
Flux air knife too strong….Blows flux off board
Board not run in best direction….Component shadowing
Flux activator low….Low flux density
Flux activity too low….Flux not aggressive enough
Cooling rate too slow….Solder not hardened before distributed
Dross recirculating from pot to wave….Excessive dross build up
Pallet center support missing or poor
Vibrator, 2nd wave too high….Causes splashing of liquid solder
Chip wave lower in spots….Solder is not evenly distributed
Air knife after wave set incorrectly….Air knife not effectively blowing off excess solder
Flux liquid in holes….Flux density too high or too much flux applied to board

1 = Low Impact

3 = High Impact

2 = Moderate Impact

225°F
Room Temp
5°F/Sec
4 ft/Min
N/A
495°F
1 sec
0.5 inches
.062 inches
< 0.3 sec
100°F
495°F
3 sec
2.0 inches
0.062
< 0.3 sec

Typical Values
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Interpreting the Expert Guide:
Example problem: Use the troubleshooting Expert’s Guide shown below.
PROBLEM (1)
In the example, Solder Bridges is the problem that has been detected.
 The next step is, follow the row to the right. Now determine the potential cause that
best fits the problem. In the columns, there are impact numbers rated 1,2 or 3.
These impact numbers help the user to decide which potential cause is most
important to the problem. There is a legend on the Expert Guide, 3 = High Impact,
2 = Moderate Impact, and 1 = Low Impact. Now read and sort out the potential
causes that best fit the problem. In the example, the solder bridges row has several
columns with impact numbers. All the probable causes should be read and the
highest potential cause that was selected is in the next step.
POTENTIAL CAUSE (2)
Conveyor speed to slow…….Increases dwell time in solder wave.
 Once the potential cause has been determined, continue following the column
down to the rows with impact numbers.
If there are no impact numbers in the WaveRIDER parameter rows, the
WaveRIDER cannot assist the user in this area.
 Now read all the WaveRIDER parameters that have impact numbers. Once the
problem WaveRIDER parameter has been determined, correct adjustments can be
made. In the example, there are several impact numbers and the one that has
been selected is in the next step.
WaveRIDER® PARAMETER (3)
It is determined that the Conveyor Speed best indicates the likely cause and the
proper adjustments should be made.

WaveRIDER
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WaveRIDER Parameter (3)

Problem (1)
Solder Bridges

Potential Cause (2)

Conveyor Speed

Chip Wave Dwell Times (A, B, C)
Chip Wave Contact Lengths (A, B, C)

Rev 1.2

Solder Wave Dwell Times (A, B, C)
Solder Wave Contact Lengths (A, B, C)

A36-9283-06

3 3 3 3 2

3

2
1

2
1

Conveyor speed too fast….Reduces dwell time in wave and forces preheat to be to high
Preheat temp low….Solder pads not within 100°F of solder wave temperature
Conveyor speed too low….increases dwell time in solder wave
Carrier bent or damaged….Board must run parallel (flat) over wave
Conveyor fingers bent….Board may not be parallel over solder wave

2 2 1

Flux applied is insufficient….Spotty application or weak activity flux
Rails not parallel (flat) over nozzles….One side of board deeper in solder wave than the other
Wave or nozzles not level….Must be parallel to conveyor

3

Wave height/exit incorrectly set….Exit speed of solder should match conveyor speed

1

Board not run in best direction….Component shadowing

1

Dross recirculating from pot to wave….Excessive dross build up

1

Air knife after wave set incorrectly….Air knife not effectively blowing off excess solder

1 = Low Impact

3 = High Impact

2 = Moderate Impact

225°F
Room Temp
5°F/Sec
4 ft/Min
N/A
495°F
1 sec
0.5 inches
.062 inches
< 0.3 sec
100°F
495°F
3 sec
2.0 inches
0.062
< 0.3 sec

Typical Values

Figure 3- 6: Troubleshooting Process
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3.4 Cleaning the Rider
After completing the data collection process, cleaning the RIDER is very important
because some types of flux tend to build up on the RIDER very quickly. The following
information will discuss various cleaning machines and methods used to clean the
RIDER, and how to get it ready for the data run.
The M.O.L.E. must be removed before the RIDER is cleaned because it may be
damaged or destroyed by water or solvents.
1) Turn the locking latch and the raise barrier box cover until it comes to a rest.
Remove the configuration plug, and pull the extractor handle to remove the
M.O.L.E..









Figure 3- 7: SuperM.O.L.E. Gold Removal

2) Using a brass wire brush with fine bristles, clean the contact sensors on the
bottom of the RIDER pallet. When cleaning the sensors, use enough force to get
them cleaned and free from debris but not too much that they will be damaged.
3) Once the M.O.L.E. is removed, make sure that the configuration plug is tucked
under the cover while it is closed and rotate the locking latch to secure.
4) Open the barrier box cover allowing inside completely dry. Once the RIDER is
dry and insert the M.O.L.E. into the RIDER.

WaveRIDER
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3.5 Storing the RIDER
The operator has several options when deciding how to store the RIDER. Deciding
where and how to store the RIDER will depend on how the work area is set up. The
RIDER has two holes on the left and right side so the operator can hang the RIDER in a
place that is out of the way of normal production flow. If there is not an available area to
hang the RIDER, put it back into the packaging case.
If the RIDER is not going to be used for a long period of time, the Power pack
battery may lose its charge and may need to be recharged.

STORAGE
HOLES

Figure 3- 8: Proper RIDER Storage
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4.0 Worksheet Descriptions
The following sections offer brief explanations for the worksheet functions, and how
they benefit the user. Refer to section 5.0 Menu and Tool Commands for information on
the menu commands.
4.1 The Welcome Worksheet
The Welcome worksheet is the introductory worksheet. This worksheet contains a
WaveRIDER introductory illustration and a text box for entering a company or workbook
name.
Welcome worksheet features:
• Menus and Toolbar
•

Company/Report Name Text Box

MENUS
TOOLBAR

COMPANY NAME TEXT BOX
Figure 4- 1: Welcome Worksheet

WaveRIDER

♦29♦

4.1.1 Welcome Worksheet Menus and Toolbar
•

Menus: File, View, WaveRIDER, Navigate, and Help.

•

Toolbar Buttons: Print, Zoom In, Zoom Out, 100%, Read WaveRIDER Data,
and About.

Figure 4- 2: Welcome Worksheet Menus and Toolbar Buttons
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4.1.2 Company/Report Name
The text box located on the bottom half of the Welcome worksheet allows the user
enter a company or report name.
To enter a name:
1) Using the mouse pointer, click in the text box.
2) Type a desired name and then hit the [enter] key to accept or [esc] to cancel.

Figure 4- 3: Entering a Company Name
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4.2 WaveRIDER Data Worksheet
The WaveRIDER Data worksheet is where individual data runs are viewed in single
page format.
WaveRIDER Data worksheet features:
• Menus and Toolbar
•

Data sheet

MENUS
TOOLBAR
DATA SHEET

Figure 4- 4: WaveRIDER Data Worksheet
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4.2.1 WaveRIDER Data Worksheet Menus and Toolbar Buttons
•

Menus: File, View, WaveRIDER, Navigate, and Help.

•

Toolbar buttons: Print, Zoom In, Zoom Out, 100%, Read WaveRIDER Data,
About, First (data run of the data set), Back (to previous data run), Forward (to
the next data run), and Last (data run of the data set).

Figure 4- 5: WaveRIDER Data Worksheet Menus and Toolbar Buttons
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4.2.2 Interpreting the WaveRIDER Data Sheet
The following section defines the features of the WaveRIDER Data sheet. The Group
Parameters on the data sheet are color coded so when they are viewed on other
worksheets they can be easily associated with the Label Parameters.

Figure 4- 6: Document View

(1)
(2)
(3)
(4)
(5)
(6)

Company Name, Machine Name, and Part Number configured by user.
Pre-heat Parameters and Conveyor speed.
Chip Wave Parameters (Blank column if there is no chip wave).
Solder Wave Parameters.
M.O.L.E. Internal Status.
Overall Coupon Parameters.

Refer to APPENDIX C: Measurement Definitions for Parameter defintions

If a parameter has no value (blank) that means that there was insufficient
contacts detected to give a complete reqort.
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4.2.3 Data Coloring and LSL / USL
The parameter data and the user specified LSL (Lower Specification Limit) and USL
(Upper Specification Limit) text fields on the Admin (Administration) worksheet are
linked to indicate that a parameter has exceeded a user specified specification limit. If a
USL has been exceeded, that parameter will be underlined and appear on the Data
sheet in Red (indicating it is above the specification limit). If a parameter is less than
the user specified LSL, that parameter will be underlined and appear in the Data sheet
in Blue (indicating below the specification limit).

EXCEEDED USL
PARAMETER (RED)

EXCEEDED LSL
PARAMETER (BLUE)

Figure 4- 7: Data Coloring

See section 4.5.4 Specification and Control Limit Cells for information on how to
enter user LSL and USL values.
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4.3 Spreadsheet Worksheet
The Spreadsheet worksheet contains data that is collected by the WaveRIDER, and is
put into standard spreadsheet format. Each row in the spreadsheet represents one data
run. Using the Admin worksheet in conjunction with the Spreadsheet worksheet the
user can select parameters to be displayed on the worksheet.
Spreadsheet Worksheet features:
• Menus and Toolbar

•

Statistics

•

Parameter Group (color coded)

•

User Definable Columns

•

Parameter Labels

•

Parameter Units

•

Data Run Rows

•

Filters

PARAMETER
LABELS

PARAMETER
UNITS

FILTERS

MENUS
TOOLBAR
PARAMETER
GROUPS

DATA RUN
ROWS

SELECTED
DATA RUN

USER DEFINABLE
COLUMNS
Figure 4- 8: Spreadsheet Worksheet
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4.3.1 Spreadsheet Menus and Toolbar Buttons
•

Menus: File, Edit, View, Format, Window, WaveRIDER, and Help.

•

Toolbar buttons: New, Open, Save Workbook, Print, Undo, Redo, Zoom In,
Zoom Out, 100%, Align left, Center, Align right, Bold, Italic, Underline, Read
WaveRIDER Data, Dock Printout Settings, and About.

Figure 4- 9: Spreadsheet Worksheet Menus and Toolbar Buttons
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4.3.2 Parameter Groups
Parameter Groups are the headers for a specific group of data parameters collected by
the M.O.L.E.. They are color coded with the associated Parameter Labels so they can
be easily identified together.
The width of each parameter column can be adjusted to be larger or smaller by
placing the mouse pointer over a split line dividing the parameter columns and
sliding it to the desired width.
PARAMETER GROUP

SPLIT-LINE POINTER.

Figure 4- 10: Parameter Group
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The Parameter Groups are defined as the following:
User Defined Parameter Group:
These parameter columns can be used to
enter text to help identify the row with unique
information about that run (i.e. shift, operator,
line number, part number). This information will
also appear in the Tool Status box on the
Profile worksheet.
General Parameter Group:

This group contains file information associated
with the run such as; date and time, (of profile)
and the data file tag.

Preheat Parameter Group:

This group contains Pre-heat Temperature
Data.

M.O.L.E. Parameter Group:

This group contains the physical condition of
the M.O.L.E. at the end of the run.

Chip Wave Parameter Group:

This group contains the thermal and
mechanical data from the Chip Wave (first of
two waves).

Solder Wave Parameter Group:

This group contains the thermal and
mechanical data from the Solder Wave.

Coupon Parameter Group:

This group contains the coupon temperature,
and Slope data.

WaveRIDER
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4.3.3 Parameter Labels
The Parameter Labels are where all of the specific parameters for each group are
listed. The user can decide which parameters will be shown on the Spreadsheet
worksheet from the Admin worksheet as discussed in section 4.5.3 Parameter check
boxes.

PARAMETER LABEL

Figure 4- 11: Parameter Label

4.3.4 Parameter Units
The Parameter Units are the units of measurement for that parameter. For example, in
the Preheat Group Parameter, the Parameter Label Temp: is in °F.

PARAMETER UNITS

Figure 4- 12: Parameter Units
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4.3.5 Data Run Rows
All of the data runs uploaded into a workbook file are listed on the Spreadsheet
worksheet as individual rows. The first data run uploaded into the workbook file is on
the bottom and the most recent data run uploaded is on the top.
When any data run row is selected, all of the cells in the entire row are highlighted in
purple and blue. The purple cells indicate that the cells can be modified and the blue
cells indicate the data cannot be modified.
When any individual data cell in a data run row is selected, all of the cells in the entire
row are highlighted in green and yellow. The green cells indicate that the cells can be
modified and the yellow cells indicate the data cannot be modified.
The data run rows can also be moved into any order desired. This is useful when the
user wants to place similar data runs together.
To change the order of the data run:
1) Select the number cell of a data run row with the mouse pointer. The row will
then become highlighted in purple and blue.
2) Drag the row and drop it to a desired location.

Figure 4- 13: Drag and Drop Data Rows

4.3.6 Selected Run
When a data run row is selected, the data for that row will be shown in the Sel= row
located at the bottom of the data run rows. This row also allows the user to easily
compare the selected data row to the statistics calculations located below the selected
run row.
Entire selected rows and columns can be “copied” by pressing keys (CTRL + C)
and then “pasted” (Ctrl + V) into other spreadsheet applications.
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4.3.7 Filters
There are Filters for each parameter label that filter specific data out of runs listing.
Filtering more than one column at a time acts as a Logical AND Function. All
conditions of all set filters must be met for data row(s) to remain visible.
How to use the Filter function:
1) Click the Filter button to reveal the unique data as populated in that column
under that particular parameter label.
2) Select a desired data value to filter, or the two standard filters All and Special.
FILTER ARROW BUTTON

Figure 4- 14: Filter Function

♦42♦

WaveRIDER

To use the All option:
1) Select All to reset the filter for that column and view all of the data run rows that
meet the other column filters.
To use the Special option:
1) Select Special to select data run rows within a range of values. There are multiple
options to select information to filter by clicking the appropriate relational
operators option button (See Figure 4- 15). The user can either select data from
a populated list or type it in the text box on the top of the column.
=
>
<

equal to
Greater than
less than

>= greater than or equal to
<= less than or equal to
<> Not equal to

Figure 4- 15: filter option buttons
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2) Select a data filter by:
Clicking the greater than relational operator option button beside the left data
column.
Click a parameter value from the list or type it in the text box.
Click the AND logical operator option button.
Click the less than relational operator option button beside the right data column.
Click a parameter value from the list or type it in the text box.
The Clear command button can be selected at any time to clear the selections and
the new values can be selected.
3) Click the OK command button to accept the selected data filters or Cancel to
return to the worksheet without executing the filter request.

Figure 4- 16: Special Filter Feature Dialog Box

In this example, the data filtered would be all times between, but not including 06:25:33
and 14:08:00.
To reset all of the data set rows to restore the entire set of collected data, click
the Filter Reset button on the Spreadsheet worksheet.
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4.3.8 Statistics
There are rows located on the bottom of the Spreadsheet worksheet, which are the
combined calculations for all the data runs that are currently being viewed in the
Spreadsheet worksheet display. The following information is the definitions for each
Statistics row:
• N = Number of samples included in the calculations
•

Min. = The lowest value in the parameter column.

•

Max. = The highest value the parameter column.

•

Avg = The average of all values in the parameter column.

•

Std. Dev. = The standard deviation of the values in that column.
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4.4 Profile Worksheet
The Profile worksheet is where a selected data run is represented graphically. The
software allows the user to analyze the data and to compute statistics based on the
data.
Profile worksheet features:
 Menus and Toolbar



Data Tabs

 M.O.L.E. Status



Status Bar

 Tool Box Status



Data Table

 Magnify Map



Scale

 Sensor Locations



Data Graph

 Channel Check Boxes

MENUS
TOOLBAR
M.O.L.E.
STATUS

DATA
GRAPH

TOOL
STATUS
BOX
MAGNIFY
MAP

CHANNEL
CHECK
BOXES
DATA TABS
STATUS BAR

SENSOR LOCATIONS

DATA TABLE

Figure 4- 17: Profile Worksheet

♦46♦

WaveRIDER

4.4.1 Profile Menus and Toolbar Buttons
•

Menus: File, Edit, Window, WaveRIDER, Profile, Tools, Navigate, and Help.

•

Toolbar buttons: New, Open, Save Workbook, Print, Magnify, Slope, Peak
Difference, Overlay, 3-D, Notes, Erase Object(s), Erase All, Read WaveRIDER
Data, Dock Printout Settings, About, First (data run of the data set), Back (to
previous data run), Forward (to the next data run), and Last (data run of the data
set).

Figure 4- 18: Profile Worksheet Menus and Toolbar Buttons
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4.4.2 M.O.L.E. Status
The M.O.L.E. STATUS box contains information about the status of the M.O.L.E. while it
collected the data the selected run.

MOLE STATUS

Figure 4- 19: M.O.L.E. Status Window

Max Internal T: This is the highest internal temperature logged during the displayed
profile and is displayed in degrees Celsius. If the highest temperature logged is
in the specified internal operating temperature range of is 0-54°C, it appears in
BLACK. When the internal temperature is 55-64°C, it appears in YELLOW
indicating that the M.O.L.E. has reached the Warning zone and is approaching
the maximum recommended operating temperature of 65°C. If the internal
operating temperature is above 65°C, it appears in RED indicating that the
maximum internal operating range has been reached.
Battery: The battery voltage measured during the upload of that run. The nominal
range for normal operation is 5.1 to 4.7V.
Points: The number of data samples recorded at the configured interval.
Active: Indicates which channels were active during the experiment. A number
means an active channel; a “O” is an inactive channel. An "X" means an open or
out of range T/C was detected on that channel during the data run.
Interval: Time between data shown in hours, minutes, seconds, and tenths of
seconds data points: hh:mm:ss.t.
Date: Date of last data point logged.
Time: Time of last data point logged.
V: Firmware Version displays the operating code of the M.O.L.E. (This is where
customer service will ask you to find the version number for the M.O.L.E.)
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4.4.3 Tool Status Box
The Tool Status box displays information on how to use a selected tool command and
other information during tool use. Prior to using a tool command, the Tool Status box
displays the Spreadsheet worksheet User definable column information that is
associated with the selected data run.
When a Tool command, such as Magnify, is selected, a message appears in the box
stating “Click and drag to select area”.

TOOL
STATUS

Figure 4- 20: Tool Status Message

Once the user has completed the tool command, the user data will be displayed again.
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4.4.4 Magnify Map
The Magnify Map displays a small map of the entire profile and indicates the area
currently magnified with a red crosshatched box.

MAGNIFIED
AREA

Figure 4- 21: Magnify Map
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4.4.5 The Data Table
The Data Table includes various values depending on which Data Tab is selected. The
rows always indicate the channel and the columns vary depending on which data tab is
active.

DATA TABLE
Figure 4- 22: Data Table
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4.4.5.1 Value Pop-up
Each value in the Data Table can be displayed as a Value Pop-up. A Value Pop-up is
graphically illustrated on the Data Graph showing how and where that value was
extracted from the profile.
Only one Value Pop-up can be displayed on the Data Graph at a time.
VALUE POP-UP

SELECTED VALUE
Figure 4- 23: Value Pop-up

To display a Value Pop-up:
1) Select the Profile worksheet.
2) Move the mouse cursor and pause over a desired value in the Data Table. That
value will automatically be displayed on the Data Graph where that value was
extracted.
The last displayed Value Pop-up will remain on the Data Graph until the user
selects a different worksheet.
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4.4.5.2 Show/Hide Columns
Data Table parameter columns on the Profile worksheet can be hidden. This is useful
when an operator wants to focus attention to the most important parameter columns.

Figure 4- 24: Show/Hide Columns

To display Show/Hide columns:
1) Select the Profile worksheet.
2) Right click a parameter column header.
3) Clear a parameter check box to hide or select to display.
Hidden Parameter columns do not affect the data being collected for that
parameter. If all Parameter columns are hidden, right-click the Sensor locations
column header to open the Show/Hide column dialog box.
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4.3.5.3 Change Summary Stats Settings
When creating a new workbook, a dialog box appears allowing the user to specify
Summary Statistics settings based on user selected values.
If the process changes or an operator wishes to perform test experiments, these
settings can be changed by clicking a parameter column header on the Profile
worksheet.

Figure 4-25: Modify Summary Stat Settings

To Change Summary Stats Settings:
1) Select the Profile worksheet.
2) Select the Summary Stats tab.
3) Click the Time Above or Time between column header.
4) Change the desired Summary Stats settings and select the OK command to
accept.
5) Once the new settings have been accepted, the software prompts the user to
decide if these new settings should be applied to future data run profiles.
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4.3.5.4 Change Slope Calculator
Positive and negative slope profile parameter calculator allows the user to calculate
straight line slopes between any two temperatures. (Default to liquidous and liquidous
to peak).
If the process changes or an operator wishes to perform test experiments, these
settings can be changed by clicking a parameter column header on the Profile
worksheet.

Figure 4- 26: Modify Summary Stat Settings

To Change Slope Calculator:
1) Select the Profile worksheet.
2) Select the Summary Stats tab.
3) Click a Peak Slope column header.
4) Change the desired settings and select the OK command to accept.
5) Once the new settings have been accepted, the software prompts the user to
decide if these new settings should be applied to future data run profiles.
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4.4.6 Sensor Locations
The location for each sensor labeled in the Data Table. The color and description
indicates which Data Plot on the Data Graph it designates. The top three sensor
location descriptions are the Coupon Top, Coupon Solder, and Coupon Bottom
sensors. The bottom three are the A, B and C speed sensors.

SENSOR
DESCRIPTIONS

Figure 4- 27: Sensor Location Descriptions
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4.4.7 Channel Check Boxes
The Channel check boxes control whether the associated Data Plot is displayed on the
Data Graph and whether the data for that channel are included in the data table. To
view or remove a Data Plot, click the channel check box beside a sensor location
description to turn it “ON” or “OFF”.

CHANNEL CHECK BOXES

Figure 4- 28: Channel Check Boxes
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4.4.8 Status Bar
The Status Bar shows the available Help information, X-Y position of the mouse
pointer, current date and time.

HELP INFORMATION

X-Y READOUT

DATE & TIME

Figure 4- 29: Status Bar Features
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• Help Information
When the mouse pointer is placed over a Toolbar button the left side of the Status bar
will display the action that button performs.
• X/Y Readout
It is easy to find the exact X and Y-values of any point on the Data Graph using the
mouse pointer. The X/Y Readout continuously displays the X and Y-axes values of the
mouse pointer location.
The units displayed for X and Y-values are the same as those displayed on the graph.
The user can select between °F and °C for the Y-value units. The X-value units can be
a data point number, time, or distance. Units can be changed on the X and Y-axes at
any time by selecting the Units command in the Profile menu.
While using the Magnify tool, the X/Y Readout displays the size of the selected
area of interest.

Other ways to view exact X- and Y-coordinates of a data point is to select the
Value Tab.
 Date and Time
This area of the Status bar displays the current time and date of the PC.
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4.4.9 Data Tabs
Data Tabs is where the user can view a variety of sensor information in the Data Table.
The Data Tabs are:
• Value
•

Time to Ref

•

T above Ref

•

Statistics

•

Summary Statistics

•

KPI (Key Process Indicators)
Only one data tab can be active at a time. Each is described below.
When the Magnify tool is used to zoom in on a portion of the Data Graph, the Data
Table displays the statistics for those values that are displayed. (This feature
does not apply to the Summary Stats Data Tab).
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4.4.9.1 Value
When the Value Tab is selected, the Data Table lists the temperature at the point where
an X-cursor intersects a Data Plot. There are four X-cursors and the positions can be
changed at any time by moving the X-cursor (Refer to the descriptions in section
4.4.10.5 X-Cursors). As an X-cursor is moved, the values in the Data Table are
automatically updated.

Figure 4- 30: Value Data Tab

Values in the Data Table depend on the units of the X and Y-axis.
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4.4.9.2 Time to Reference
When the Time to Reference Tab is selected, the Data Table displays the time it takes
the channels to reach fixed Temperature Reference Line(s). Times are expressed as
HH:MM:SS (H=hours, M=minutes, S=seconds). Up to three Temperature Reference
Lines can be added to the Data Graph that are used in this statistic by using the Temp
Ref Lines command in the Profile menu.

Figure 4- 31: Time to Ref Data Tab
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4.4.9.3 T Above Ref
When the T Above Ref Tab is selected, the Data Table shows the amount of time each
sensor measured data above the Temperature Reference Lines. Times are expressed
as HH:MM:SS (H=hours, M=minutes, S=seconds) and are the total time above
reference line regardless of when the value was above.

Figure 4- 32: T Above Ref Data Tab

Temperature Reference Lines can be added, deleted, or moved at any time using
the Temp Ref Lines command in the Profile menu.
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4.4.9.4 Statistics
When the Statistics Tab is selected, the first four columns of the Data Table displays the
minimum and maximum temperature found for each Data Plot and the value of X (time,
distance, or point number) at which it occurred.
The last two columns of the Data Table displays the Average (Mean) and Standard
Deviation of the temperature values recorded for each sensor.

Figure 4- 33: Statistics Data Tab

If a portion of the Data Graph is magnified using the Magnify tool, the Data Table
displays the Mean and Standard Deviation of the values currently displayed.

♦64♦

WaveRIDER

4.4.9.5 Summary Statistics
When the Summary Stats Tab is selected, the Data Table displays a summary of primary
statistics from the entire data set. These summary statistics always display the statistics
derived from the entire profile regardless of the level the Data Graph is zoomed.

Figure 4- 34: Summary Statistics
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4.4.9.6 KPI (Key Process Indicators)
When KPI is the active data tab, the Data Table displays statistics from the Profile
configured by the user. This is useful so the user can display the most important
information that best suits their needs or application.

Figure 4- 35: KPI Data Tab
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Key Process Indicators Setup:
1) Make sure the KPI Data Tab is active.
2) Click the KPI Setup button above the Sensor Locations descriptions.
The KPI Setup can also be activated by right-clicking a column header.

Figure 4- 36: KPI Setup

3) Click the desired parameters to display in the Data Table. The parameters are
grouped by Temperature, Cursor data with slope between, and Time. The user
can also select to display Range, Average and Standard Deviation rows for each
of the columns.
4) When finished select the OK button to display the new settings or Cancel to
return to the worksheet without making any changes.
A maximum of 12-16 parameter columns can be displayed at one time. As
columns populate the Data Table, they are automatically sized to fit. It is
recommended that the most beneficial column information is displayed to
achieve the best results.
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4.4.10 The Data Graph
The Data Graph is a display that shows the data collected from the data run overlaid on
a graph. The user can analyze and highlight various process features with the tools
listed below.
• X and Y-Axes and Labels
•

Autoscaling

•

Data Plots

•

Process Origin

•

X-Cursors

•

X-axis Units

•

Temperature Reference Lines
The Data Graph features are described in the sections that follow. Some of these
features described are also controlled using the appropriate menu options. Refer to
section 5.0 Menu and Tool Commands for more information.
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4.4.10.1 X and Y-Axes and Labels
The Y-axis (vertical) displays the scale of the measured temperature. Lower values are
at the bottom and higher values at the top.
The Y-axis includes temperature labels on the left side of the graph. These four
temperatures divide the vertical axis into four equal parts and are automatically scaled
to fit the current Y-axis limits. These units can be displayed in Celsius or Fahrenheit
using the Units command in the Preferences sub-menu on the Admin worksheet.
The X-axis (horizontal) displays values data points collected. The X-axis can be
converted from data points to time or distance using the X-Axis Units command in the
Profile menu.
To see the X-value of any location on the Data Graph, the software provides two
different methods:
• The X/Y Readout in the Status bar continuously displays both X and Y-values at
the location of the mouse pointer. Details of this feature are described in section
4.4.8 Status Bar.
•

The X-value at the position of each X-Cursor is displayed in the Data Table when
the Value statistic is active.

4.4.10.2 Autoscaling
The software includes a powerful Autoscaling option to automatically scale the Data
Graph so the data will always be visible and easy to work with. The software will
automatically select a range of values for both the X and Y-axes to ensure that all the
data fits on the screen. The user can change the range of Y-values displayed in Manual
mode by entering a manual mode using the Scaling command in the Profile menu.
Another way to scale the graph’s X and Y-axes is to use the Magnify tool
described in section 5.8.1 Magnify Tool.
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4.4.10.3 Data Plots
The Data Plots in the Data Graph represent the data for each of the WaveRIDER
sensors. Each sensor is represented by a different color that corresponds to the color of
its sensor location description in the Data Table.

DATA PLOTS

Figure 4- 37: Data Plots

A Data Plot in the Data Graph can be suppressed or restored at any time by clicking the
check box with the corresponding sensor description in the Data Table. This allows the
user to view any combination of the Data Plots or individually.
When two or more Data Plots overlap the same values, the Data Plots overwrite
each other. For example, if the Data Plot that represents the Coupon Top sensor
and Coupon Bottom have the same value, the Coupon Top Data Plot will only
appear unless the user suppresses it.
When printing a Data Graph in black and white, suppressing one or more Data Plots is
useful for clearing a view of a Data Plot that is obscured by others near it.
When printing the Data Graph in black and white, the Notes tool can be used to
help identify each Data Plot.
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4.4.10.4 Process Origin
The Process Origin is a gray vertical line at the left edge of the Data Graph to indicate
where the process starts. The Process Origin is automatically set by the software when
the data is uploaded from the M.O.L.E.. When Points or Distance units are being used
for the X-values, the X-values to the left of the Process Origin are displayed as negative
and those to the right as positive.

PROCESS
ORIGIN

Figure 4- 38: Process Origin

To move the Process Origin:
1) Select the Process Origin line by positioning the mouse pointer anywhere on the
line.
2) Press and hold the left mouse button.
3) Move the line by dragging it left or right.
4) Release the mouse button when the Process Origin is at the desired location.
The X/Y Readout in the Status Bar indicates the true position of the Process Origin
while it is being moving. After the mouse button is released, the X-Readout changes to
zero at the Process Origin and displays negative numbers for X when the mouse
pointer is moved to the left of the Process Origin.
X-Cursor values are automatically adjusted when the Process Origin is moved.
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4.4.10.5 X-Cursors
The Data Graph has four X-cursors that indicate the temperature values at the
intersection of a Data Plot with each X-cursor. When the Value Data Tab is selected,
these values are displayed in the Data Table in four data columns labeled C1, C2, C3,
and C4, representing X-cursor 1 through X-cursor 4 respectively.

X-CURSORS

VALUE STATISTICS TAB
Figure 4- 39: X-Cursors
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To move an X-cursor:
1) Select the Value Data Tab.
2) Position the mouse pointer over the X-cursor grip (the small triangle below a Xcursor) then press and hold the left mouse button and drag it left or right
releasing the mouse button when the X-cursor is at the desired location.
•

The user can also press the [tab] key to toggle select an X-cursor. When the
desired X-cursor is selected, the small triangle will turn red. Then pressing either
the left or right arrow keys will step the X-cursors. Each step is one pixel or one
degree which ever is larger. This feature achieves cursor positions that are more
precise.

Moving the selected cursor can be pushed into other cursors causing them to
move them ahead of it.
The position of an X-cursor controls the values displayed in the Data Table. When an
X-cursor is moved, values in the Data Table are automatically updated.
The Data Table includes a row for each of the sensors on the WaveRIDER. The
numbers in the four columns indicate the Y-values at the intersection of a Data Plot with
an X-cursor. (Refer to section 4.4.9 Data Tabs)
When an X-cursor is dragged to a new position, it automatically snaps to the closest
real X-value. Notice on highly magnified graphs that the cursor jumps from point to
point. In an extreme case, if the graph is so highly magnified that there are no real Xvalues to move to, the X-cursors cannot be moved at all.
The Process Origin is the initial point from which all X-axis position data is
calculated. After releasing the Process Origin at the appropriate point on the
graph, X-cursor values are recalculated and displayed.
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4.4.10.6 X-axis Units
The user can select three different types of X scales for the X-axis. The scales are
Point, Time (time measure from process origin), and Distance. To change, select the Xaxis Units command in the Profile menu.
The scale is displayed only when a data tab other than Value is selected.

LOGGED
POINT
SCALE

TIME

DISTANCE
SCALE
Figure 4- 40: Scale Types

♦74♦

WaveRIDER

4.4.10.7 Temperature Reference Lines
Temperature Reference Lines are colored horizontal lines that are positioned within the
range of Y-values in the graph. Up to three Temperature reference lines can be added
to the Data Graph using the Temp Ref Lines command in the Profile menu.

TEMP REF
LINE

Figure 4- 41: Temp Ref Lines

Temperature Reference Lines are used in analysis when the T Above Ref (Time above
the Reference Line) statistic is active. (T Above Ref statistic is described in section
4.4.9.3 T Above Ref).
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4.5 Administration Worksheet
The Administration worksheet is where all of the WaveRIDER parameters are
controlled. The parameters collected by the M.O.L.E. are in the Spreadsheet parameter
column located on the left side of the worksheet. Each parameter has a check box for
viewing (or not) on the Spreadsheet worksheet. The right side of the Admin worksheet
contains SPC sheet setup boxes, for defining the SPC charts. There is also an option to
specify LSL (Lower Specification Limits), USL (Upper Specification Limits), LCL (Lower
Control Limits), and UCL (Upper Control Limits) in the cells located to the right of each
parameter.
Admin Worksheet features:


Menus and Toolbar buttons

•

Spec and Control Limit Cells



Spreadsheet Parameters

•

SPC Sub-Group Size



Parameter check boxes

•

SPC Sheet Parameter Boxes

SPREADSHEET
PARAMETERS

SPEC LIMIT
CELLS

CONTROL LIMIT
CELLS

SPC SHEET
PARAMETER
BOXES

SPC SUB-GROUP SIZE

MENUS
TOOLBAR
PARAMETER
CHECK
BOXES

Figure 4- 42: Administration Worksheet
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4.5.1 Administration Menus and Toolbar Buttons
•

Menus: File, Edit, View, Format, Window, WaveRIDER, and Help.

•

Toolbar buttons: New, Open, Save, Print, Undo, Redo, Zoom In, Zoom Out,
100%, Align left, Center, Align right, Bold, Italic, Underline, Read WaveRIDER
Data, Dock Printout Settings, and About.

Figure 4- 43: Admin Worksheet Menu Bar and Tool Buttons
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4.5.2 Spreadsheet Parameters
The Spreadsheet Parameters are arranged in a column that contains all of the
parameters that the WaveRIDER collects during a data run. The parameters are
arranged by colors as described in section 4.3.2 Parameter Groups. Each cell has the
Group Parameter listed first and the Label Parameter listed second.

LABEL PARAMETERS
GROUP PARAMETERS

Figure 4- 44: Spreadsheet Parameters Defined

4.5.3 Parameter check boxes
The Admin worksheet has a corresponding check box located on the left of each
Spreadsheet parameter. To display a parameter on the Spreadsheet worksheet, click
the corresponding check box. Similarly if you do not want to view the parameter,
remove the check mark by clicking the check box. When a parameter check box is
colored, this indicates these parameters are typically more significant and are helpful to
analyze.
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4.5.4 Specification and Control Limit Cells
There are cells to the right of each parameter for specifying an LSL (lower specification
limit) and an USL (upper specification limit) for each parameter. The user can also
specify an LCL (upper control limit) and UCL (upper control limit) to be applied to a SPC
chart.
• LSL and USL Cells
These limits notify the user if the parameter is above or below the LSL or USL during a
data run. When a parameter is below the user specified LSL, it appears on the
WaveRIDER Data worksheet in blue and will be underlined. When a parameter is
above the user specified USL it appears on the WaveRIDER Data worksheet in red and
will be underlined.
USER
CONTROLLED
LSL & USL

LSL & USL
CELLS

Figure 4- 45: User Specified Specification Limits
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• User Controlled LSL and USL
The user can automatically set a LSL and USL for each parameter by using a drop
down list box that contains options to set the LSL to -3, -2, -1, standard deviation or –
10% and –5%. The USL can be set to +3, +2, +1 standard deviation or +10% and +5%.

Figure 4- 46: User Controlled LSL and USL

The values calculated are taken from the current data viewed on the Spreadsheet
worksheet.
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• LCL and UCL Cells
Lower and Upper control limits are automatically calculated from the Spreadsheet
parameter data and displayed on the SPC control charts when an SPC worksheet is
created. The LCL and UCL cells allow the user to override the calculated limits and
manually set them.
USER
CONTROLLED
LCL & UCL

LCL & UCL
CELLS

Figure 4- 47: User Specified Control Limits
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• User Controlled LCL and UCL
The user can automatically set a LCL and UCL for each parameter by using a drop
down list box that contains options to set the LCL to -3, -2, -1, standard deviation or –
10% and –5%. The UCL can be set to +3, +2, +1 standard deviation or +10% and +5%.

Figure 4- 48: User Controlled LCL and UCL

The values calculated are taken from the current data viewed on the Spreadsheet
worksheet.
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4.5.5 SPC Sheet Boxes
The right side of the Admin worksheet contains nine SPC sheet boxes. These boxes
are used to create the SPC worksheets.

Figure 4- 49: SPC Sheet Boxes

An SPC worksheet can be created by dragging and dropping a parameter or by using
the drop down list box.
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To create a SPC Worksheet:
Drag and Drop:
1) Select a parameter and drag it from the Spreadsheet Parameter column and
drop it into a SPC Sheet cell. Up to three parameters per SPC Sheet can be
selected.
CHECK TO ACTIVATE SPC
WORKSHEET(S)

Figure 4- 50: Drag and Drop Parameter

2) When finished, click the check box in the SPC Sheet Label to activate the SPC
sheet.
3) To view the SPC Sheet, click the new SPC worksheet tab (See section 4.7 SPC
Worksheet for more details).
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Parameter list:
1) All of the SPC sheet boxes have drop down list boxes located on the right side of
the parameter cell. To select a parameter click the drop down list box arrow
button and a list of parameter groups appears.

Figure 4- 51: Drop Down List Box
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2) Select the group from the drop down list that includes the desired parameter. A
dialog box will then appear listing all of the parameters in that particular group.
3) Select the desired parameter from the list and click the OK command button.

Figure 4- 52: Parameter Dialog Box

4) When finished, click the check box in the SPC Sheet Label to activate the sheet.
5) To view the SPC Sheet, click the new SPC worksheet tab (See section 4.7 SPC
Worksheet for more details).
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Replacing and Deleting SPC Parameters:
To change the parameters in the SPC Sheet boxes, drag and drop a different
parameter over of the existing parameter or repeat the drop down list method of
selecting a parameter.
To delete a parameter, click and drag the parameter off the SPC Sheet box to remove.

Figure 4- 53: Erase Bar
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4.6 Guide Worksheet
The Guide worksheet is a quick reference guide to assist new and experienced users
through basic operation steps.

Figure 4- 54: Guide Worksheet
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4.7 SPC Worksheet
The SPC worksheets display the assembled Spreadsheet parameters using the Admin
worksheet. Each SPC worksheet can display three X-bar and R charts and up to a
maximum of nine SPC worksheets can be created.
SPC worksheet features:
• Menus and Toolbar buttons
•

X-Bar Chart

•

R Chart

•

Statistics box
STATISTICS BOX

MENUS
TOOLBAR
X-BAR CHART

R CHART

Figure 4- 55: SPC Worksheet
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4.7.1 Menus & Toolbar
•

Menus: File, View, Window, WaveRIDER Data, and Help.

•

Toolbar buttons: Print, Zoom In, Zoom Out, 100%, Read WaveRIDER Data,
About, and Context Help.

Figure 4- 56: SPC Worksheet Menu Bar and Tool Buttons
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4.7.2 X-Bar Chart
The X-Bar Chart is the graphical chart produced from samples of a selected parameter.
The chart uses a rolling average of 2 through 6 sample points specified by the user.
The X-bar is the average of the data samples and the UCL and LCL are calculated
using a formula based on the Range data.
X-BAR CHART

CALCULATIONS
NUMBER

UCL & LCL

Figure 4- 57: X-Bar Chart

The calculation numbers vary depending on the data in the Spreadsheet
worksheet. Using the filter function or the hide command allows the user to
select the specific data runs to include on the SPC chart.
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4.7.3 R Chart
The R Chart is the graphical chart produced from the selected parameter. The R-Bar is
the averages of the range samples.
If the Sub-Group size is set to 1, the R chart becomes a moving range (mR) chart.
The moving range is the difference between a specified X value and the one
preceding it.

R CHART

CALCULATION
NUMBER

UCL

R-BAR

Figure 4- 58: R Chart

The calculation numbers vary depending on the data in the Spreadsheet
worksheet. Using the filter function or the hide command allows the user to
select the specific data runs to include on the SPC chart.
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4.7.4 Statistics Box
The Statistics Box reflects the current SPC data from the selected, sorted and filtered
data set parameter.
Statistics box data:
• N = Number of subgroups.
•

Min. = The lowest data point on the graph.

•

Max. = The highest data point on the graph.

•

X-2 bar = The current X-Bar Bar calculation.

•

Std. Dev. = The Standard Deviation of the selected parameter.

•

Cp; Cpk = Process capability indeces (Refer to Appendix A for more information).

Figure 4- 59: Statistics Box
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4.7.5 Renaming SPC Worksheets
The user has the ability to rename all of the SPC worksheet tabs to best reflect the
worksheet data.
To change a worksheet name:
1) Double-click the desired SPC worksheet tab and a pop-up text box appears
above the worksheet tab.

Figure 4- 60: Pop-up Text Box

2) Type a new name in the pop-up text box and hit the [enter] key to accept or the
[esc] key to cancel.
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5.0 Menu and Tool Commands
This section explains how to use all of the Menu and Toolbar button commands. Each
of the following sections will list all of the commands specific to each of the menus.
The dimmed menu commands are used in other worksheets.
5.1 File Menu
Commands in the File menu are used to manipulate and configure workbook files.
5.1.1 New Workbook
Select the New Workbook command from the File menu to start a new workbook. A
message box appears requesting the user select a file folder directory to save the new
workbook.
After the file location has been determined, a dialog box appears allowing the user to
specify Summary Statistics settings for the workbook based on user selected values.

Figure 5- 1: Summary Statistics Settings

When a new workbook is created, it uses these values as thresholds for the Summary
Statistics Data. A table of these values extracted from the profile can be viewed on the
Summary Stats tab.
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Workbook files are saved with a file extension of (.MWR), and the Profile data
from the Profile worksheet are saved with an extension of (.MDM). These two file
types will automatically be saved in the same file folder directory because they
are inter-dependent on each other and should not be seperated.

Figure 5- 2: New List Box

The New Workbook command can be accessed on the Toolbars of the Spreadsheet,
Profile, and Admin worksheets. This command can also be used by pressing CTRL + N.
• New Workbook Button:
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5.1.2 Open Workbook
The Open Workbook command enables the user to open existing workbook files.
To open a workbook file:
1) Select the Open Workbook command from the File menu. A list box of workbook
files with an extension of (.MWR) files appears.

Figure 5- 3: Open List Box

2) Highlight the desired workbook file to open by clicking.
3) Click the Open command button to open, or Cancel to return to the current
worksheet.
More than one workbook file can be open at a time and can be viewed by using
the commands on the Window File menu (refer to section 5.5 Window Menu).
The Open command can be accessed on the Spreadsheet, Profile, and Admin
worksheet Toolbars. This command can also be used by pressing Ctrl + O.
• Open Workbook Button:
5.1.3 Close Workbook
Select the Close Workbook command from the File menu to close the current workbook.
If there is a second workbook open, closing a workbook will return to the previous
workbook.
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5.1.4 Import
The Import command imports existing (.mdm), files into the Spreadsheet worksheet.
This process will copy all documentation information (i.e. part, process) from the file
being imported, into the user definable cells on the Spreadsheet worksheet. The data
can now be saved in the new format as described under the Save and Save As menu
commands.
When importing (.MDM) files, they are automatically copied into the directory of
the current workbook file.
To import:
1) Select the Import command from the File menu and the Import list box appears.

Figure 5- 4: Import List Box

2) Navigate to the file folder where the file(s) to import are located. (The path and
file name can also be typed in the File of type text box).
3) Select the file(s) to import by clicking it once.
4) Click the Open command button.
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5.1.5 Save Workbook
Select the Save Workbook command from the File menu to save the current workbook
file after changes have been made. When the user saves the file, all of the current data
sets and options in the workbook are saved.
The Save Workbook command can be accessed on the Spreadsheet, Profile, and
Admin worksheet Toolbars. This command can also be used by pressing Ctrl + S.
• Save Button:
5.1.6 Save Workbook As
Select the Save Workbook As command from the File menu to save the current
workbook with a different file name. When the user saves the file, the current
appearance of the workbook and the options that have been set are saved to a new file
name.

Figure 5- 5: Save Workbook As List Box

The Save Workbook As command can also be used to save selected set of profiles out
of a worksheet that includes a large data set. When unwanted profiles are filtered out of
a large data set and then the Save Workbook As command is used, the selected data
runs are saved in a new workbook file along with the profile data.
This command is also useful when the user wants to transfer selected MDM data
run(s) to a floppy disk.
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5.1.7 Save As Text
Select Save As Text from the File menu to save the Spreadsheet worksheet information
as a text file in the current unit of temperature and distance configurations. The saved
text files have a file extension of (.TXT). This command will save the data so it can be
opened with software programs that open standard text files.

Figure 5- 6: Save As Text Dialog Box

5.1.8 Save as Text Archive
Select the Save As Text Archive command from the File menu to save all of the data sets
in the workbook file as a text archive with a file extension of (.WRA). This is a useful
way to save large worksheets because text archive files are much smaller than saving
in workbook file format. This allows saving large workbook spreadsheet data in a
compressed format. They can be restored using the Load Text Archive command.

Figure 5- 7: Save As Text Archive List Box
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5.1.9 Load Text Archive
Select the Load Text Archive command from the File menu to load a previously saved
text archive file. This command will clear the currently loaded data and load the
selected text archive file in its place.

Figure 5- 8: Load Text Archive List Box

To avoid loosing valuable data, it is recommended to load text archive files into a
new workbook file because as previously stated, this command clears all
currently loaded data.
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5.1.10 Configuration
The Configuration command is used to set a communication (COM) port so the PC and
the M.O.L.E. can communicate. This command is very important when the software is
first installed or PC hardware configurations have changed.
To configure a COM port:
1) Connect the M.O.L.E. to the PC (refer to the appropriate section in the Hardware
manual).
2) Select the Configuration command from the File menu on the Admin worksheet
and the Configuration dialog box appears.

Figure 5- 9: Port Configuration Dialog Box

3) Click the option button next to a COM port which the PC is set up for RS-232
communications or the Auto command button to have the software automatically
find the COM port the M.O.L.E. is connected.
4) Click the OK command button to accept or Cancel to exit without changing.
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5.1.11 Preferences
The Preferences sub-menu lets the user perform custom software setup tasks.

Figure 5- 10: Preferences Menu
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5.1.11.1 Units
The software can be configured to operate with different units of temperature and
distance.
This command does not set the units reported by the M.O.L.E. It applies only to
the software.
To change Units of Temperature or Distance Units:
1) Click the Units command from the Preferences sub-menu.
2) Click the option button beside a unit of temperature and/or unit of distance.
3) Click the OK command button to use the choices as defaults whenever the
software is started or Cancel to return to the worksheet without making any
changes.

Figure 5- 11: Units Configuration Window
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5.1.11.2 Passwords
The software has a password protection feature that uses case-sensitive text for
securing access to a worksheet. When a worksheet is password protected, the
worksheet tab will be highlighted in yellow and the user will not be able to access the
protected worksheet without proper password privileges.
If there are worksheets password protected, the password protect command will not
affect data when uploading from the M.O.L.E.. The protected worksheets just cannot be
viewed without the password.
Once the user opens a workbook and uses the Passwords command to gain access to
a protected worksheet all of the worksheets remain unprotected until that workbook is
closed.
The password command also works on a global basis. The password currently
assigned applies to all existing or new workbook files.
The software has a default password Admin. This password will be needed the
first time the password is changed or to password protect a worksheet. When the
password is changed it is very important to remember the password or write it
down.
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To password protect worksheets:
1) Click the Passwords command from the Preferences sub-menu, and a Password
Protection dialog box appears.

Figure 5- 12: Password Protection Dialog Box

2) Select which worksheet(s) to password protected by clicking the corresponding
check box.
3) Click the OK command button to accept or Cancel to return to the worksheet
without password protecting any worksheet(s).
If the OK command button has been selected, a dialog box appears prompting the user
to enter the current password.
If the default password has not been changed, the current password is Admin.

Figure 5- 13: Enter Password Dialog box

4) Enter the current password in the text box and click the OK command button to
accept or Cancel to return to the worksheet without password protecting the
selected worksheet(s).
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To change a password:
1) Select the Passwords command from the Preferences sub-menu and a Password
Protection dialog box appears.

Figure 5- 14: Password Protection Dialog Box

2) Click the Change Password command button and the Password Change dialog
box appears.

Figure 5- 15: Change Password Dialog Box.

The software has a default password Admin. When the password is changed for
the first time, Admin will need to be entered in the “Current Password” text box.
3) Enter current password in the Current Password text box.
4) Enter a new password in the New Password text box.
The software only accepts passwords with a minimum of 4 characters.
•

Enter the new password again in the Confirmation text box and then click the OK
command button to accept or Cancel to not change the password.
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To disable a password:
1) Select the Passwords command from the Preferences sub-menu and a Password
protection dialog box appears.

Figure 5- 16: Password Protection Dialog Box

2) The current password protected worksheet(s) will have a check mark in the
corresponding check box. Click the check box to remove the check mark to
unprotect the worksheet.
3) Click the OK command button and a dialog box appears asking the user to enter
the current password.

Figure 5- 17: Enter Password Dialog box

The software has the default case-sensitive password Admin. When password
protection is removed from a worksheet and the preset password has not
changed, Admin will need to be entered in the password text box.
4) The current password must now be entered in the text box. When finished click
the OK command button or Cancel to keep the current password protection.

♦108♦

WaveRIDER

5.1.11.3 File Tag Number
When data is uploaded from the M.O.L.E., the (*.MDM) portion of the data run is
automatically assigned a special File Tag number. The first two characters are
automatically assigned WR. The next nine characters are the first nine characters from
the user/computer login name and the remaining six characters are in numerical
sequence that can be specified by the user.
For example, if the User login name is “JSMITH”, a File Tag number would be
“WR_JSMITH_000100.mdm”.
If there is no user login name available, the software will automatically assign the
first nine characters from the computer name (i.e. Production, Engineering). If
both the user name and computer name are not available “USER” will be
assigned to the File Tag number (i.e. WR_USER_000100.mdm).
To change the File Tag number sequence:
1) Select the File Tag Number command from the File menu.
2) A dialog box appears so a file tag number can be entered in the text box, or the
number automatically assigned by the software can be used.

Figure 5- 18: File Tag Number Dialog Box

3) Click the OK command button to set the File Tag Number or click Cancel to close
the window without changing the number.
If a file tag number is entered that currently exists, the (.MDM) file will be
incremented automatically to avoid that file from being overwritten.

WaveRIDER

♦109♦

5.1.11.4 Contact Filters
The Contact Filters command allows the user to enter a drop out filter and Hot air knife
window values.
To set dropout time contact filter:
1) Select a time value from the drop-down box. The user can select values of 0.5,
1.0, and 1.5 seconds. The most common value is 1.0 and is the software default.
These values are used to reject contact bounce caused by turbulent waves.
To set hot air knife contact filter:
1) If your wave solder machine has an air knife, you can select the hot air knife
distance check box to activate the filter. This software default for this filter is
OFF.
2) Set the hot air knife distance. This settable distance is typically the distance from
the solder wave to the Hot air knife. This may be less if it is seen that the hot air
knife influences this temp prematurely. Range is from 0 to 30.5 cm (0 to12.0 in).

Figure 5- 19: Contact Filters Dialog box
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5.1.12 Page Setup
The Page Setup command sets page parameters for the Spreadsheet and Admin
worksheets.
To set page parameters:
1) Select the Page Setup command from the File menu and the following dialog box
appears.

Figure 5- 20: Page Setup Dialog Box

2) Select desired parameters to apply to the worksheet.
3) Click the OK command button to use the current page setup selections.
4) Click the Cancel command button to leave the page setup command without
changing anything.
Selections made using the Page Setup command will not be visible on the
worksheet it is only used for print formatting. To view the selections, use the Print
Preview command decsribed in section 5.1.15 Print Preview.
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5.1.13 Print Options
The Print Options command is where additional Data Table statistics can be selected to
be printed along with the Data Graph. Additional documentation can also be selected
that will be printed on a second page.
To select print options:
1) Select the Print Options command from the File menu and the following dialog
box appears.

Figure 5- 21: Print Options Dialog Box

2) Click the check box beside desired Statistic(s) to be printed along with the Main
Plot.
3) Click the check box beside desired documentation to be printed on a second
page.
•

Click the Print command button to close the print options process and initiate
printing.

•

Click the Print Preview command button to view the report appearance.

4) Click the OK command button to accept or Cancel command button to leave the
print options command without making any changes.
Only five Statistic(s) can be printed at one time.
This command can also be used by pressing CTRL + I.
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5.1.14 Page Header / Footer
The Page Header / Footer command places text on the top and bottom of the printed
worksheet.
Some of the worksheets contain default information in the Header and Footer
fields, to view use the Print Preview command. Refer to section 5.1.15 Print
Preview.
To add a Header and/or Footer
1) Select the Page Header/Footer command from the File menu and the following
dialog box appears.

Figure 5- 22: Header / Footer Dialog Box

2) Click the Header tab or the Footer tab.
3) Determine where to locate the text: left, center or right side of the worksheet.
Click a text field and type the desired text.
•

The user can also change the text font, distance the note is from the frame
edges and type of page numbering.

4) Click the OK command button to accept the Header / Footer or click Cancel to
return to the worksheet without changes.
The Header / Footer information will not be visible on the worksheet. It is only
used for printing. To view the Header / Footer information, use the Print Preview
command (refer to section 5.1.15 Print Preview.
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5.1.15 Print Preview
The Print Preview command shows a preview of the page(s) to be printed. This
command is useful when confirming print options.
To view a print preview:
1) Select the Print Preview command from the File menu and the Print Preview
window appears.

Figure 5- 23: Print Preview Window

2) Click the Print command button to proceed with printing.
3) Click the Two-Page command button when there is more than one page in the
report to view them side by side.
4) Click the Next Page or Prev Page command button to view other pages of a
multiple page report.
5) Click the Zoom In command button to observe small details, and Zoom Out to
restore.
6) Click the Close command button to close the Print Preview window.
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5.1.16 Print
The Print command prints worksheet information from the workbook. The options that
appear on the Print dialog box will depend on the type of printer and the installed printer
driver.
To print a worksheet:
1) Select the Print command from the File menu and standard Windows or driverdependent print dialog box appears.
2) Select desired print options.

Figure 5- 24: Print Dialog Box

3) Click the OK command button to close the Print dialog box and initiate printing
the current worksheet.
4) Click the Cancel command button to close the print window without printing.
The Print command can be accessed on all worksheet Toolbars This command can
also be used by pressing CTRL + P.
• Print Button:
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5.1.17 Report Setup
Select the Print Report command from the File menu to print the select worksheets to
print a workbook in a report style.
To setup a report:
1) Select the Report Setup command from the File menu and the Report Setup
dialog box appears.

Figure 5- 25: Report Setup Dialog Box

2) Click the check box(es) to enable the worksheet(s) to be printed.
3) Click the OK command button to accept the selection(s) and return to the
worksheet, or click Cancel to return to the worksheet without any changes.
5.1.18 Print Report
Select the Print Report command from the File menu to print the selected worksheets
from the Report Setup dialog box as discussed in section 5.1.17 Report Setup.
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5.1.19 Send to Mail Recipients
The Send to Mail Recipients sub-menu commands let the user send a Screen image,
MDM, or Workbook and associated MDM’s to an email recipient. This command is
useful when the user would like to share profiles and/or workbooks with other locations
or when troubleshooting problems.

Figure 5- 26: Preferences Menu

To send:
1) Launch an email program (i.e. Outlook, endora).
2) Select the desired email command described below:
•

Select Screen Image to capture the current displayed worksheet screen.

When selecting the Screen Image command, the software captures the current
screen image where the command is activated and converts it into a Bitmap
(filetag.bmp) file.
•

Select MDM File to send the MDM file from the currently selected data run.

•

Select Workbook and associated MDM’s to send the current Workbook and
associated MDM files.

3) Enter an email address in the email text box and select the OK command button
to send the file and return to the worksheet where the command was activated.

Figure 5- 27: Enter Recipients

When sending files the email program may display an message dialog that
informs the user that it is sending the email.
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5.1.20 Recent Files 1, 2, 3, etc...
The most recently loaded workbook file names are displayed at the bottom of the File
menu. To open one of these files, click the name of the desired workbook file or press
the appropriate number beside it.
5.1.21 Exit
Select the Exit command to quit the program. A message box will prompt the user to
save changes. If the user decides to save the changes, all data and configuration
changes will be saved with the workbook file.
5.1.22 Language
All of the menus and commands have been translated in five different languages. After
the software is installed, the user can select a different language from the Languages
sub-menu in the File menu.

♦118♦

WaveRIDER

5.2 Edit Menu
The Edit menu commands enable the user to modify the data set on the Spreadsheet
and Admin worksheets so the most beneficial data is assembled in the workbook file.
5.2.1 Undo
Select the Undo command to undo any previous action. For example if the filter
command is used and then the user decides that command was not necessary, the
Undo command will restore it back to its original format.
The Undo command can be accessed on the Toolbars of the Spreadsheet and Admin
worksheets. This command can also be used by pressing CTRL + Z.
• Undo Button:
5.2.2 Redo
Select the Redo command to restore the action made by using the Undo command. Like
Undo, the user can use Redo to restore all of the Undo actions.
The Redo command can be accessed on the Toolbars of the Spreadsheet and Admin
worksheets. This command can also be used by pressing CTRL + R.
Redo Button:
5.2.3 Copy
Select the copy command to copy the data in the Spreadsheet cells for pasting into
other user definable cells or different programs. This command can also be used by
pressing CTRL +C.
5.2.4 Paste
Select the Paste command to insert collected data in the user definable cells or
different programs. This command can also be used by pressing CTRL +V.
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5.2.5 Remove Row
Select the Remove Row command to remove a data run row that is not wanted. This
command is helpful when data has been collected and the user feels it is not beneficial
to the workbook data set or has a corrupted MDM file.
This command is permanent and the data run cannot be retrieved. The software
program will warn the user with a message box.
5.2.6 Hide Row
Select the Hide Row command to exclude a row without eliminating it completely from
the workbook file. This command is similar to the filter function, and is helpful when
data has been collected and it may not be beneficial to the data set. To restore hidden
data set row(s) click the Red Filter Reset button located on the Spreadsheet worksheet
(refer to section 4.3.7 Filters).
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5.3 View Menu
The View menu commands enable the user to manipulate which areas are viewed on
the worksheet display.
5.3.1 Zoom In
Select the Zoom In command from the View menu to make the current worksheet view
larger. The Zoom In command has the capability to zoom in multiple times. When the
maximum zoom level has been reached the Zoom In command will be dimmed.
The Zoom In command can be accessed on all worksheet Toolbars excluding the
Profile worksheet. This button will speed up the Zoom In process if multiple zooms are
desired.
• Zoom In Button:
5.3.2 Zoom Out
Select the Zoom Out command from the View menu to make the current worksheet view
smaller. The Zoom Out command has the capability to zoom out multiple times. When
the minimum zoom has been reached the Zoom Out command will be dimmed.
The Zoom Out command can be accessed on all worksheet Toolbars excluding the
Profile worksheet. This button will speed up the Zoom Out process if multiple zooms
are desired.
• Zoom Out Button:
5.3.3 100%
Select the 100% command from the View menu to return the worksheet to its default
display size.
The 100% command can be accessed on all worksheet Toolbars excluding the Profile
worksheet.
• 100% Button:
5.3.4 Data Table Tabs
The Data Table Tabs sub-menu commands let the user show or hide the Data Table
tabs on the Profile worksheet. When a Data Table tab is displayed a check mark
appears beside the command on the menu.
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5.4 Format Menu
The Format menu includes commands that change the layout or pattern of the text in
user configurable cells.
5.4.1 Bold
Select the Bold command from the Format menu to turn data in a user configurable cell
bold. Select the Bold command again to return to standard format.
The Bold command can be accessed on the Toolbar of the Spreadsheet and Admin
worksheets.
• Bold Button:
5.4.2 Italic
Select the Italic command from the Format menu to turn data in a user configurable cell
italic. Select the Italic command again to return to standard format.
The Italic command can be accessed on the Toolbar of the Spreadsheet and Admin
worksheets.
• Italic Button:
5.4.3 Underline
Select the Underline command from the Format menu to underline data in a user
configurable cell. Select the underline command again to return to standard format.
The Underline command can be accessed on the Toolbar of the Spreadsheet and
Admin worksheets.
• Underline Button:
5.4.4 Alignment (Left, Center, Right)
Select the Left, Center or Right command from the Format menu to align data in a user
configurable cell.
The alignment commands can be accessed on the Toolbar of the Spreadsheet and
Admin worksheet.
• Alignment Buttons:
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(Align Left, Center, and Align Right)
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5.5 Window Menu
The Window menu arranges opened workbook files for viewing and quick access.
5.5.1 Cascade
Select the Cascade command from the Window menu to cascade opened workbook files
from the upper left corner overlapping the workbooks downward so each workbook Title
bar is visible.

Figure 5- 28: Cascaded Workbook Files
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5.5.2 Tile
Select the Tile command from the Windows menu to arrange the open workbook files in
a rectangular fashion dividing the workbook files into smaller sizes arranged so they fit
next to each other on the display.

Figure 5- 29: Tiled Workbook Files

5.5.3 Open File
This section of the Window menu shows the currently opened workbook files. This
allows quick access to all of the opened workbook files. Selecting a workbook file name
to bring it to the front of the opened workbooks and make it active.
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5.6 WaveRIDER Menu
The WaveRIDER menu commands configure the M.O.L.E. for collecting data.
The M.O.L.E. must be connected to a PC and the proper communication port
must be configured to properly use the WaveRIDER menu commands.
5.6.1 Configuration Wizard
This wizard guides a user through the communications setup process so the software
and M.O.L.E. can communicate. Communications configuration needs to be done when
the software is first installed or PC hardware configurations have changed.
The wizard steps can be accessed individually on the File and WaveRIDER menus.
To configure communications:
1) Connect the M.O.L.E. to the PC (refer to the appropriate section in the Hardware
manual).
2) Select the Configuration Wizard command from the M.O.L.E. menu and the
Configuration dialog box appears.

Figure 5- 30: Wizard Step 1 – Configuration

3) Click the option button next to a COM port which the PC is set up for RS-232
communications or the Auto command button to have the software automatically
find the COM port the M.O.L.E. is connected.
The user can exit the Configuration Wizard any time by selecting the Cancel
button.
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4) Enter the correct month, day, year, hour, minute, and second by adjusting the
slider(s) or manually typing in the corresponding text box.

Figure 5- 31: Wizard Step 3 -Set Instrument Clock

When the Set Instrument Clock dialog box appears the current computer clock
setting is automatically entered in the text boxes.
5) Click the OK button to reset the clock.
Configuration is now complete and the M.O.L.E. is ready to collect data.
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5.6.2 Set M.O.L.E. Clock
The M.O.L.E. has an internal clock it uses to identify the time and date of each data run
and to control when each measurement is recorded. The M.O.L.E. clock should be set
prior to data collection to ensure that the proper time was recorded.

Figure 5- 32: Set M.O.L.E. Clock Dialog Box

To set the M.O.L.E. clock:
1) Connect the M.O.L.E. to the PC (refer to the appropriate section in the Hardware
manual).
2) Select the Set M.O.L.E. Clock command from the WaveRIDER menu.
3) Enter the correct month, day, year, hour, minute, and second by adjusting the
slider(s) or manually typing in the corresponding text box.
When the Set Instrument Clock dialog box appears the current computer clock
setting is automatically entered in the text boxes.
4) Click the Send button to reset the clock.
When the setting of the clock is completed, a dialog box with the configuration data
appears.
To read the M.O.L.E. clock:
1) Connect the M.O.L.E. to the PC (refer to the appropriate section in the Hardware
manual).
2) Select the Set M.O.L.E. Clock command from the WaveRIDER menu.
3) Click the Read command button to display the current date and time from the
M.O.L.E.. If the clock is set wrong, the date or time will be incorrect.
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5.6.3 WaveRIDER Settings
The M.O.L.E. can be configured to store the name of your company, operator or
machine name.
To select WaveRIDER settings:
1) Connect the M.O.L.E. to the PC (refer to the appropriate section in the Hardware
manual).
2) Select the WaveRIDER Settings command from the WaveRIDER menu.
3) Type a company, operator, or machine name in the text box.

Figure 5- 33: WaveRIDER Settings

4) Click the Send command button to store the information in the M.O.L.E.
5) When the process is complete, a dialog box appears confirming the information
sent. Click the OK command button and the Set M.O.L.E. Clock dialog box
appears for verification of the clock settings. Click the OK command button and
the software will return to the worksheet.
Using this command may cause the M.O.L.E. to lose any previous data collected.
The WaveRIDER Settings command can be accessed on the Toolbars of the
Spreadsheet, Profile, and Admin worksheets.
• WaveRIDER Setting Button:
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5.6.4 Read WaveRIDER Data
The Read WaveRIDER Data command starts the data transfer process after
completing the data collection process.
To read WaveRIDER data:
1) Connect the M.O.L.E. to the PC (refer to the appropriate section in the Hardware
manual).
2) Select the Read WaveRIDER Data command from the WaveRIDER menu and a
status bar dialog box appears indicating that data retrieval from the M.O.L.E. has
begun.

Figure 5- 34: Read WaveRIDER Dialog Box

Once data transfer is complete, the dialog box will disappear and will return to the
current worksheet.
If the WaveRIDER has not collected enough data to create a complete profile a
message box appears (See Figure 5- 35).

Figure 5- 35: Communication Error Dialog box

The Read WaveRIDER Data command can be accessed on all worksheet Toolbars.
• Read WaveRIDER Data Button:
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5.7 Profile Menu
The Profile menu includes special commands specifically used on the Profile
worksheet. Commands in this menu enable the user to view and edit experimental
documentation, change the appearance of the display and design experiments.
5.7.1 Part
Part documentation is information about the part being profiled. There are also fields for
entering the date the data was recorded, a user name, part number or identification of
the component being profiled. To enter Part Documentation select the Part command
from the Profile menu and a dialog box appears.
The part date field automatically updates when reading data from the M.O.L.E.

Figure 5- 36: Part Dialog Box
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5.7.2 Process
Select the Process command from the Profile menu to enter and edit information about
the process that generated the profile data.

Figure 5- 37: Process Dialog Box
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5.7.3 Scaling
The Scaling command controls the scale of the X and Y axis units of the Data Graph on
the Profile worksheet.
To use the scaling command:
1) Select the Scaling command from the Profile menu, and the scaling dialog box
appears. This dialog box identifies the current settings of the displayed Y-axis
units and the maximum and minimum values of the Y-axis.

Figure 5- 38: Scaling Window

2) Select between Auto or Manual mode. In Auto mode, the software selects the
scale of the Y-axis to ensure all data point values and the highest zone
temperature settings are visible in the Data Graph. In Manual mode, the range of
values for the Y-axis can be manually set.
3) Click the OK button to use the new settings or Cancel to return to the Profile
worksheet with no changes.
The Scaling command is not avalible if the Data Graph has been magnified.
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5.7.4 X-Axis Units
The X-Axis Units command is where the unit type for the Data Graph X-axis is selected.
To select a X axis unit:
1) Select the X-axis Units command from the Profile menu and the Units dialog box
appears.

Figure 5- 39: Units Dialog Box

2) Click the option button beside Point, Time or Distance to select the units for the Xaxis.
•

Point: the data points collected from the Process Origin.

•

Time: Time measured from the Process Origin

•

Distance: Distance from the Process Origin (Meters, Centimeters, Feet or
Inches).

3) Click the OK command button to return to the worksheet using the new settings
or Cancel to make no new changes.
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5.7.5 Temp Ref Lines (Temperature Reference Lines)
Temperature Reference Lines are colored horizontal lines and can be positioned
anywhere within the range of Y-values in the graph using the Temp Ref Lines command
in the Profile menu.
Temperature Reference Lines are used for analysis when the T Above Ref
(Time above the Reference Line) statistic is active (refer to section 4.4.9.3 T Above
Ref)

Figure 5- 40: Temp Ref Lines Dialog Box

The Temp Ref Lines dialog box identifies the units of the Y-axis and the current values
of any Temperature reference lines in the Data Graph. Temperature reference lines can
be added or changed at any time and must be created before the T Above Ref statistic
will produce valid data in the Data Table.
To add Temperature Reference Lines to the Data Graph:
1) Select the Temp Ref Lines command from the Profile menu.
2) Click the check box above Low, Med, or Hi to draw that line in the graph.
3) Enter Y-axis value(s) by adjusting the slider position or typing it in the text box.
4) Click the OK command to return to the Profile worksheet using the new settings
or Cancel to not make any changes.
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5.7.6 Profile Colors
The Profile Colors command changes the display and print colors for the sensor Data
Plots.
To change sensor channel colors:
1) Select Profile Colors from the Profile menu and the Select Colors dialog box
appears.
When the colors are changed it will affect all existing and new workbooks.

Figure 5- 41: Profile Colors Dialog Box

2) Click the desired sensor and a Windows default color pallet appears.
3) Selected a new color and click the OK command button to accept and exit the
color pallet. (Repeat for all of the other channels).
4) Click the OK command to accept or Cancel to not make any changes.


Click the Defaults command button to restore the colors to the original default
colors.
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5.8 Tools Menu
Options in this menu help you manipulate and analyze the profile data.
5.8.1 Magnify Tool
The Magnify tool enlarges any selected area of the data graph for easy visual
examination.
To Magnify a portion of the Data Graph:
1) Click the Magnify tool from the Tools menu.
2) Position the mouse pointer on a corner of the area to enlarge.
3) Press the left mouse button and drag the pointer diagonally to the opposite
corner to form a box around the area to be magnified. An outline of the box
appears as you drag.
4) Release the left mouse button when the outline of the area to be magnified is
visible. The area inside the box is then magnified to fill the entire Data Graph.
To show even more detail in the Data Graph, Magnify can be performed multiple
times. If the Magnify tool reaches the maximum zoom capability the software will
display a message box informing that the user has “Zoomed to Tight”.
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When using the Magnify tool, the Magnify Map uses a red box to indicate the area
currently magnified. If the Data Graph was previously magnified, the current level of
magnification is the red box and previous magnified areas are noted with gray boxes.

MAGNIFIED
AREA
MAGNIFY
MAP

Figure 5- 42: Magnify Map

When the Magnify tool has been used multiple times, click a red box in the Magnify
map once to go back to a previously selected level of magnification or the white area to
return to the full view.
Magnify Applications:
Magnify is useful for visually examining data, when statistics are used. The statistics
(Value, Time to Ref., T Above Ref, and Statistics) compute only data points that fall
within the area of the Data Graph. This enables the user to focus the statistical analysis
on any portion of time, distance, or data point number in the graph.
The Magnify command can be accessed on the Profile worksheet Toolbar.
• Magnify Button:
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5.8.2 Slope Tool
The Slope tool finds the average slope between any two points in the Data Graph.
To find the average slope of a line:
1) Select the Slope tool from the Tools menu.
2) Position the mouse pointer at a point on the curve.
3) Press and hold the left mouse button.
4) Drag the pointer to the end of the desired slope line.
5) Release the left mouse button when the pointer is at the desired location. The
software will draw a slope line on the Data Graph, and label the slope value.

SLOPE
DATA
SLOPE
LINE

Figure 5- 43: Slope Tool
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To obtain more accurate slopes:
Magnify a portion of the Data Graph using the Magnify tool, and repeat this procedure.
To remove the slope line from the Data Graph, select the Erase Object(s) command from
the Tool menu and follow instructions in the Tool Status box (refer to section 5.8.8
Erase Object(s)).
Slope Applications:
Use the Slope tool to find the average slope between any two points on the graph.
Longer slope lines tend to produce more accurate slope calculations.
The Slope tool can be used to compare actual data with ideal conditions by drawing a
line with a known slope (to represent the ideal condition) beside a portion of a Data
Plot.
Slope Limitations:
Slope calculations are based on logged points connected by the slope line. Points
occur only at the exact time intervals used to record data.
The Slope tool cannot measure slopes when dx (change in X) is equal to zero (when
the line is vertical).
The Slope tool can be accessed on the Profile worksheet Toolbar.
• Slope Button:
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5.8.3 Peak Difference Tool
The Peak Difference tool displays the difference in value between the peak of the
maximum Data Plot and the peak of the minimum Data Plot in any location of the Data
Graph. This command is especially useful for measuring side-to-side heating
differences in ovens.
To display the peak difference between Data Plots:
1) Select the Peak Difference tool from the Profile menu.
2) Position the mouse pointer on a corner of the area you want to analyze.
3) Press the left mouse button and drag the pointer diagonally to the opposite
corner to form a Peak difference box. An outline of the box appears as you drag.
The peak difference is calculated as the maximum difference between the highest peak
and the lowest peak within the rectangle.
To remove the peak difference rectangle and annotation from the Data Graph,
select the Erase Objects command from the Tools menu and follow instructions in
the Tool status box (See section 5.8.8 Erase Object(s)).

PEAK
DIFFERENCE

Figure 3-9: Peak Difference Tool

The Peak Difference tool can be accessed on the Profile worksheet Toolbar.
• Peak Difference Button:
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5.8.4 Overlay Tool
The Overlay tool displays a second Data run profile for comparison with the currently
displayed Data run.
To compare two Data Plots:
1) Click the Overlay tool from the Tools menu. A list box of data files uploaded into
the opened workbook appears.
2) Select a data run file to overlay on the original by clicking it.
The data file will be inserted at the same process origin and automatically scaled to the
same Y-axis with the Overlaid file name displayed in the Tool status box. The original
Data Plot remains as solid lines while those added for comparison are dashed.
The dashed “Overlay” Data Plots are the same color as the original Data Plots.

Figure 3-10: Overlay Tool

To remove the overlaid Data Graph from the original Data Graph select the
Overlay tool again or press the right mouse button.
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Overlay Applications:
The Overlay and Magnify tools can be used together to overlay and compare ideal
reference profiles and magnified portions of the two data files. They can have different
but overlapping X-values (times, point numbers, logging intervals) or temperatures.
Overlay Limitations:
If the Data Plots are too numerous to clearly see the information of interest, they can be
suppressed by removing the check mark from the desired channel in one or both files.
This must be done to the overlaid profile prior to using the Overlay tool. Save that graph
and use the Overlay tool again.
The Overlay tool can be accessed on the Profile worksheet Toolbar.
• Overlay Button:
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5.8.5 3-D View
The 3-D tool draws a 3-dimensional representation of the temperature data. When the
3-D tool is selected a dialog box appears prompting the user to select a “Normal” or a
“Reverse-Angle” view. A “Normal” view displays the Coupon Top sensor in back and
Coupon Bottom sensor in front, and a “Reverse-Angle” view displays the Coupon
Bottom sensor in the back and Coupon Top sensor in front.
The 3-D profile, shown below, is useful for comparing the general smoothness of the
Data Plots for each sensor or showing uniform temperature across the coupon.

Figure 5- 44: Normal View
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Figure 5- 45: Reverse-Angle View

To remove the 3-D profile, click the 3D tool, or click the right mouse button.
The 3-D tool can be accessed on the Profile worksheet Toolbar.
• 3-D Button:
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5.8.6 Measure Tool
The Measure tool is similar to the Slope tool except it measures the distance between
any two points on the Profile worksheet Data Graph. This tool adds a line labeled with
the distance values to the graph, and notes the change in X and change in Y (Delta X
and Delta Y) instead of the slope.

MEASURE
DATA

Figure 5- 46: Measure Tool

To find the distance between two points:
1) Select the Measure tool from the Tools menu.
2) Position the mouse pointer at a point on the curve.
3) Press and hold the left mouse button.
4) Drag the pointer to the end of the desired point on the curve.
5) Release the left mouse button when the pointer is at the desired location and a
slope line labeled with the change in X and Y appears on the Data Graph.
To obtain more accurate distances, magnify a portion of the Data Graph using the
Magnify tool and repeat this procedure.
To remove the annotated distance from the Data Graph, select the Erase Objects
command from the Tools menu and follow instructions in the Tool status box (See
section 5.8.8 Erase Object(s)).
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5.8.7 Notes Tool
The Notes tool adds a leader with text to any portion on the Data Graph to label special
points of interest.
To add notes to the Data Graph:
1) Select the Notes tool from the Tools menu.
2) Position the mouse pointer at the desired location to start the note leader, click
and drag the mouse pointer to the desired location for the note text and release
the mouse button.
3) A dialog box will then appear allowing the user to enter a note by typing it in the
text box. There also are options to customize the color, border and font size of
the notes.

Figure 5- 47: Notes Dialog Box

4) Click the OK command button or press the [enter] key to finish adding the note.
To remove notes from the Data Graph, select the Erase Objects command from the
Tools menu and follow instructions in the Tool status box (See section 5.8.8 Erase
Object(s)).
The Notes tool can be accessed on the Profile worksheet Toolbar.
• Notes Button:
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5.8.8 Erase Object(s)
The Erase Object(s) command deletes objects and information that have been added
to the Data Graph.
To erase object(s):
1) Select the Erase Object(s) command from the Tools menu.
2) Position the mouse pointer beside the object(s) to erase.
3) Press the left mouse button and drag diagonally to outline the object(s) to be
deleted.
4) A message box asking, “Do you wish to erase this object?” appears for each object
selected. (The object that the question is referring to will be surrounded by a red
dashed box).
5) Click the Yes command button to continue erasing, or the No command button to
cancel the operation.
If the Erase Objects command is selected and there are no object(s) to be
deleted, click the right mouse button to escape from that command.
The Erase Object(s) command can be accessed on the Profile worksheet Toolbar.
• Erase Object(s) Button:
5.8.9 Erase All
The Erase All command deletes, in one operation, all the objects and information that
have been added to the Data Graph.
This operation is not reversable, so use with CAUTION.
To erase all objects:
1) Select the Erase All command from the Tools menu.
2) A message box appears asking, “Do you really want to erase all your objects”.
3) Click the Yes command button to continue erasing, or the No command button to
cancel the operation.
If the Erase All command is selected and there are no object(s) to be deleted, the
erase all command will simply redraw the screen.
The Erase All command can be accessed on the Toolbar of the Set & Verify worksheet.
Erase All Button:
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5.9 Navigate Menu
When viewing a data run on the Profile worksheet, the Navigate menu allows the user
to view other Profiles without having to select them from the Spreadsheet worksheet. It
enables the user to view profiles that are one above or below the one currently being
viewed, or jump to the first or last one uploaded into the open workbook.
Navigate Buttons
The Navigate commands can be accessed on the WaveRIDER and Profile worksheet
Toolbars.
FIRST DATA RUN

DATA RUN DROP
DOWN LIST
LAST DATA RUN

FORWARD TO
NEXT DATA RUN
BACK TO PREVIOUS
DATA RUN
Figure 5- 48: Navigate Tool Buttons
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5.10 Help Menu
The Help menu commands are useful when information is needed quickly or when this
Users guide is not available.
5.10.1 Help
The Help Index is a complete reference tool that can be used at any time. Select the
Help command from the Help menu and Adobe Acrobat Reader will automatically
launch the users guide in a PDF document. You may now search for the help topic of
your choice.
5.10.2 ECD on the Web
You can access more help by using ECD web commands. Let us help you by using the
linked commands to the ECD Web site.

Figure 5- 49: ECD Web Sub-Menu

5.10.3 About WaveRIDER
Select About WaveRIDER from the Help menu to display the software version, release
date and company information.
PRODUCT NAME
AND VERSION
COMPUTER
NAME
USER LOGIN
NAME

Figure 5- 50: About WaveRIDER Dialog Box

The About command can be accessed on all of the worksheet Toolbars.
• About Button:
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6.0 Service and Calibration
General Service Information:
This section covers maintaining and troubleshooting the coupon thermocouples,
software, wiring, and other parts of the system.
The following service instructions are for use by qualified personnel only. Refer
to the summary and service safety summary prior to performing any service.
6.1 Service Troubleshooting
Check the appropriate section of the manual to be sure you’re following the correct
procedures.
Decide if the problem is with the RIDER, SuperM.O.L.E. Gold, or Software.
Once it has been determined what item is causing the problem, refer to the appropriate
service section. Problems that are more likely or more easily corrected are listed first in
each section. Start at the top of the list and work your way down. If the problem is still
unresolved go to section 6.4 How to Get Additional Help.
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6.1.1 RIDER Troubleshooting Steps
Decide if the problem is with the Super M.O.L.E. Gold Hardware, communications or
Software.
• If the problem occurs while attempting to log data, the Hardware may be faulty.
•

If the problem occurs while attempting to communicate between SuperM.O.L.E.
Gold and the PC, the Communications links may be faulty.

•

If the problem occurs while attempting to use some other function of the
WaveRIDER Software, the software may be faulty.

Incorrect or Inappropriate Readings:
Time, Speed or Contact Length measurements are dependent on good sensor contact
with the solder wave. The most frequent causes of poor solder wave contact are:
1) Extremely turbulent solder wave.
•

Solder wave splash causes the wave to "miss" the sensor.

2) Extremely shallow or low solder wave.
•

The solder wave may be too low to reach the contacts.

•

The solder wave may be in contact less then 0.1 sec.

•

Raise wave, or lower RIDER.

3) Lack of solder flux.
•

Although not required, some flux does aid in duplicating the same conditions
your product sees.

4) Too much flux or flux build-up over time.
•

Flux may insulate the sensor from the solder wave.

•

Clean the Pallet or sensor contacts (See section 3.5 Storing the RIDER).

5) Contact corrosion.
•

The flux may be too active and is corroding the contact material

6) Active acid fluxer can cause incorrect contact detection.
•

Start the RIDER after flux has been applied or run without flux

7) Fast conveyor speed readings can be caused by oven T/C’s on the conveyor.
•

Replace coupon if suspected.
Temperature readings are taken from the three coupon sensors. Shorted or open T/Cs
are the most common cause of errors. A shorted T/C will read near room temp or
respond very slow relative to the other sensors. An open T/C will cause a sudden rise in
the temperature graph printout and often ###°F or C values on the tables.
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6.2 RIDER Coupon Replacement
To install a replacement RIDER coupon, the old or damaged coupon must first
removed. Use the following steps to remove and replace the coupon:
1) Unplug the Male Type “K” thermocouple connectors from the female connectors.
2) Loosen the coupon guides by unscrewing the four black screws.
It is recommended to clean the accumilation of flux that may have built up in the
coupon support groove.
3) Slide the replacement coupon assembly into the bottom coupon support grove.
4) Replace the coupon guides and align them with the coupon support holes.
5) Place the four screws in the holes and tighten them snugly.
6) Plug the three Type “K” male coupon thermocouple connectors into the three
Type “K” female coupon thermocouple connectors.

RIDER
COUPON
SUPPORT
GROOVE
TYPE “K” FEMALE COUPON
T/C CONNECTORS
COUPON GUIDES

TYPE “K” MALE COUPON
T/C CONNECTORS

COUPON

Figure 5-51: Coupon Replacement
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6.3 Checking the Coupon Thermocouples
Open thermocouples or loose connections may cause erratic readings. Visually check
the thermocouples visually for breaks, crimps, or crushed insulation. With an ohmmeter
or continuity indicator, check the thermocouples at the plugs. Tighten any loose or
suspect connections. Replace the coupon if it still does not operate properly.
6.4 How to Get Additional Help
If you still have problems, let us help you. We offer many ways to service your
problems. You can call our Sevice/Test technicians, visit our web site to view our FAQ
section (Frequently asked Questions) or send us an e-mail explaining your problem in
detail.
When calling our Service/Test technicians or sending us an e-mail, please include the
following information:
• Product Description (i.e. WaveRIDER, Coupon)
•

Software Version (i.e. 5.22)

Here is the information on how to contact ECD:
Telephone: (503) 659-6100
FAX: (503) 654-4422
Technical Support: (800) 323-4548
Email: ecd@ecd.com
Internet: http://www.ecd.com
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APPENDIX A: Specifications
Electrical/Mechanical Spec:
Weight:
9” – 3.0 lbs (1352 grams)
12” - 3.8 lbs (1633 grams)
15” – 4.1 lbs (1787 grams)
Physical Dimensions:

Length: 12” (30.5cm)
Height : 1.3” (3.3cm)
Width: 9” (22.9cm), 12” (30.5cm), 15” (38.1mm)
18” (45.7cm), Custom (more than 5.7”, less than 18”).

Power:

Rechargeable Ni-Cad Power Pack
Charge Time: 14 hours
Expected Power Pack life: up to 400 charging cycles.
Number of runs per charge: 10 (Based on 9 minute runs)

Temperature Accuracy: T/C Sensor: (standard limits of error) ±4°F (2.2°C)
CJC Sensor: ±4.5°F (2.5°C) absolute
A/D System: ±0.3°F (0.17°C)
Conformity to IPTS-68 : ±0.1°F (0.06°C)
Channel to Channel: ±1.8°F (1°C)
Calibration points: 212°F (100°C) and 1832°F (1000°C)
±1.8°F (1°C)
Resolution:
Printed: 1°F (1°C)
Calculation: 0.1°F
Range: -200° - +2282°F (-129°C - +1250°C)
Time Accuracy:

Time base: 1% of total seconds
Resolution: (Log rate) 0.1 seconds

Data Capacity:

9 minutes 6 seconds

Real-time
Clock/Calendar:

±1 minute/month at 25°C

Environmental
Temperature:



Pallet - Short term 300°F (149°C)
Long term 200°F (93°C)

IPTS-68 (International Practical Temperature Scale of 1968)
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APPENDIX B: Statistical Process Control (SPC) Background Information
This appendix deals with the subset of SPC that is incorporated into WaveRIDER SPC.
It does not address general SPC principals. A working knowledge of general statistical
principals and SPC terms is assumed and is not addressed here. There are many good
basic SPC books where this information may be obtained.
Wave Solder operators, engineers and production managers are expected to
understand their wave soldering process so as to deliver quality products cost
effectively. This is a continuous process.
First, the wave solder machine must be checked for consistency. A standard or typical
set up should be routinely checked prior to any process set point determinations, or
actual production run machine checks. Only after the machine has been determined to
be operating correctly and not experiencing abnormal variation, should data from the
wave solder machine be utilized. SPC is all about identifying common or normal
variation from abnormal variation.
Second, the correct process set points must be determined for a particular product.
Utilizing the ECD SuperM.O.L.E. Gold profiler, the correct set points for a particular
product may be determined. These set points, if selected correctly and followed, should
deliver the maximum throughput of quality product.
Third, the wave solder machine must consistently deliver the correctly determined set
points. SPC will help identify common or normal variation from abnormal variation.
Checking the wave solder machine using your ECD WaveRIDER with its SPC capability
will help ensure that the reflow oven is consistently performing to it’s set points and your
expectations.
Fourth, repeat the above three steps. Continuous improvement is a never-ending cycle.
Check the long-term variation of the wave solder machine by graphing typical set point
samples. Using the SuperM.O.L.E. Gold profiler, recheck/adjust part number specific
set points to maximize your quality throughput. Check the machine during a part
number run to control the machine variation from that part number’s actual ideal set
points.
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In the real world you may not want or be able to run your WaveRIDER through your
wave solder machine continuously to collect process data. A more typical scenario is to
check the machine by running the WaveRIDER through periodically: once per shift,
once per day, once per week, or once after every maintenance cycle. In addition
checking the wave solder machine at the start, middle or end of every part number run,
at the start and end of every part number run or once during a part number run could be
typical scenarios. Make sure you generate SPC charts based on data sets that had the
same set points each time. Otherwise the charts will not be meaningful.
While SPC had its start in high volume repetitive operations, SPC is applicable to many
other types of operations as well. However SPC can be difficult to apply to short runs.
Short runs may be runs that take a short time to process, runs in which multiple
samples are difficult to collect, and runs where samples are difficult to place into
subgroups or runs where small quantities are run at a time.
There are several basic short run SPC techniques:
1) Nominals Charts
2) Individuals/Moving Range Charts
3) Moving Average/Moving Range Charts
4) Standardized Formula Charts
The Moving Average/Moving Range Chart technique is particularly well suited for
situations where control information is desired as soon as possible and there is a
relatively long time between sample collections. After considering the nature of wave
solder operations and the wave solder machine sampling process, the Moving
Average/Moving Range Chart technique was incorporated into WaveRIDER SPC.
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Moving Average/Moving Range Chart Technique:
WaveRIDER SPC utilizes the standard Moving Average/Moving Range Charting
technique with a subgroup size of 2-6 that is selected by the user. The following steps
and figure illustrates the Moving Average/Moving Range calculations (using a group
size of two) that are used to construct the SPC chart.
Steps for Creating a Moving Average Moving Range Control Chart
1) Select the key variable to monitor.
2) Select the moving average group size. (We will use two in our example.)
3) Obtain your first sample and record it as sample 1 (X1).
4) Obtain your second sample and record it as sample 2 (X2).
5) Determine the x-bar and R values.
Moving Average formulas:
X=

X1 + X2
2

(Range)R=X - X
H L

6) Plot this value on the chart as subgroup 1.
7) Carry forward sample 2 into subgroup 2’s calculation. Obtain your third sample
and record it as sample 3. The averages of sample 2 and sample 3 form
subgroup 2.
8) Plot this value on the chart as subgroup 2.
9) Repeat for all the samples.
10) Calculate control limits using standard x-bar and R formulas for the appropriate
sample sizes. WR SPC uses range-based calculations for LCL and UCL.
11) Continue monitoring the process.
SAMPLE #
SAMPLE MEASUREMENTS
SUBGROUP VALUE

1
3
x
R

2
4
3.5
1

3
5
4.5
1

4
3
4
2

5
2
2.5
1

6
9
5.5
7

7
5
7
4

8
2
3.5
3

9
6
4
4

10
8
7
2

11
4
6
4

12
8
6
4

13
5
6.5
3

14
6
5.5
1

15
3
4.5
3

Figure A-1: Moving Average/Moving Range Subgroup Size 2 Calculations Chart
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16
3
3
0

Process Capability
A process capability index is a standard measure of how a process compares with its
specification limits—how a process is performing relative to how it is supposed to
perform. As opposed to the control chart, which shows detailed information about how
the data compares with control limits, a capability index is a summary of how the data
compares with the specification limits.
Two common capability indicators are Cp and Cpk. These values are shown in the
Statistics Box on each SPC Worksheet.

For both of the index values, the data used to determine them is dictated by the
subgroup size (N) chosen by the user. In the case where N=1, individual data is used—
for N>1, average data is used (x bar).
The figures below give a graphical representation of the concept of Cp and Cpk. Notice
that in each graph, the same upper and lower specification limits (USL, LSL) are used.
The values of Cp and Cpk will differ according to the data that is compared with those
specifications.
Depending on the particular process being monitored, the desired value for Cp and Cpk
may differ. In general, however, a Cp and Cpk of 1.33 or above is desired. This
assures that the process is not only capable of meeting the required specification limits,
but also has a built-in margin for error that may be needed in special circumstances. In
addition to targeting a certain minimum Cp and Cpk, it is also desirable to have these
two values equal one another. This indicates that the process is well-centered between
the specification limits.
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Cp ≥ 1.33: Data tightly distributed.
Cpk ≥ 1.33: Data well inside spec limits.

Cp = 1.00: Data fills entire spec range.
Cpk = 1.00: Data fills entire spec range.

Cp > 1.00: Data tightly distributed. If it
were centered between the spec limits,
no data would lie beyond those limits.
Cpk < 1.00: Some data is outside the
spec limits.

Cp < 1.00: Data not tightly distributed. If
it were centered between the spec
limits, some data would still lie outside
those limits.
Cpk < 1.00: Some data is outside the
spec limits.
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The equations used to calculate the index values are as follows:
Cp =

USL − LSL
6 * ( Std .Dev.)

Cpk =

USL − x
3 * ( Std .Dev.)

OR

Cpk =

x − LSL
, whichever is less
3 * ( Std .Dev.)

As can be interpreted from the above equations, Cp gives an indication of how narrow
the data distribution is relative to the width of the specification limits. Essentially, it
indicates how well the process would be able to stay within the specified limits if the
data were perfectly centered between those limits.
Cpk compares the widest half of the data distribution to the appropriate specification
limit. It indicates whether the process is capable of meeting the specification as
indicated by the “worst half” of the measurements. Unlike Cp, the Cpk index measures
process capability without assuming the data is well-centered.
The figures below give a graphical representation of the concept of Cp and Cpk. Notice
that in each graph, the same upper and lower specification limits (USL, LSL) are used.
The values of Cp and Cpk will differ according to the data that is compared with those
specifications.
Depending on the particular process being monitored, the desired value for Cp and Cpk
may differ. In general, however, a Cp and Cpk of 1.33 or above is desired. This
assures that the process is not only capable of meeting the required specification limits,
but also has a built-in margin for error that may be needed in special circumstances. In
addition to targeting a certain minimum Cp and Cpk, it is also desirable to have these
two values equal one another. This indicates that the process is well-centered between
the specification limits.
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APPENDIX C: Measurement Definitions
This section defines how each solder machine parameter is measured and or
calculated:

SPEED
SENSOR

BOTTOM FOIL
SENSOR
DWELL TIME
SENSORS
(C, B, A)

SOLDER
SENSOR
TOP FOIL
SENSOR

Figure C- 1: Sensor Placements

PREHEAT
Preheat Max Temp: The temperature of the Top Foil Thermocouple (Coupon Top) at
the time when the Speed Sensor hits the first solder wave (chip wave or main wave).
This records the change in temperature imposed by the preheat system on the top foil
of a typical circuit board.
Preheat Min Temperature: The temperature of the Top Foil Thermocouple (T/C) at the
first data point taken after the start button is pressed. This records the starting
temperature of the top foil of the circuit board.
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Preheat Max Slope: The largest temperature slope (positive or negative) seen on the
Top Foil T/C between start and the Speed Sensor hitting the first wave (chip or main
wave).
Slope is measured over a 1 second time interval using a “linear regression”
technique (m = Slope).

Conveyor (speed): The conveyor speed is found by dividing 9.75” (distance between C
and Speed sensors) by the time measured between the C and Speed sensors hitting
the main wave.
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SOLDER WAVE
Delta T at Wave: The maximum overall temperature seen on the Top Foil T/C after the
Speed Sensor hits the main wave minus the temperature of the Top Foil T/C as the
Speed Sensor hits the main wave. This records the change in temperature imposed by
the main wave on the top foil of a typical circuit board.
Contact Temperature: The maximum temperature seen on the Coupon Solder T/C
after the Speed Sensor hits the solder wave to a user settable distance after the Speed
Sensor disconnects from the main wave. This settable distance is typically the distance
from the solder wave to the Hot air knife but may be less if it is seen that the hot air
knife influences this temp prematurely. Range is from 0 to 30.5 cm (0 to12.0 in). The
default is that this filter is off so the solder contact temp max is looked for to the end of
the profile data.
Dwell Time (A, B, C): The time measured between the respective sensors entering and
exiting the main wave. This records the total time each of the three sensors (A, B, C)
spends in contact with the main wave.
Contact Length: The Dwell Time at A, B, and C times the measured Conveyor Speed.
This records the total length of circuit board in contact with the main wave at any given
instant while in the wave.
Immersion Depth: This is a function of Contact Length and is calculated based on a
known basic wave shape. This records the height of a free flowing solder wave relative
to the bottom of the WaveRIDER pallet.

Figure C- 2: Wave Height

Parallelism: The Dwell Time at sensor C minus the Dwell Time at sensor A. This
records the contact time difference between the left and right sides of the circuit board,
which is a function of how parallel the bottom of the WaveRIDER pallet is to the crest of
the wave.
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CHIP WAVE
Delta T at Wave: The maximum overall temperature seen on the Top Foil T/C between
the time the Speed Sensor hits the chip and main solder waves minus the Max Preheat
Temp. This records the change in temperature imposed by the chip wave on the top
foil of a typical circuit board.
Contact Temp: The maximum temperature seen by the Exposed T/C between the time
the Speed Sensor hits the chip and main waves. This records the surface temperature
of the chip wave.
Dwell Time (A, B, C); Contact Length; and Parallelism: These parameters are
measured using the same techniques as those for the solder wave Dwell Times, except
they are relative to the chip wave.
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Chip Detection
Chip wave data is determined in the same manner as the solder wave. The presence of
a chip wave is automatically detected when two solder contact points are detected on
sensors A or B, or four solder contact points measured by sensor “C” / Speed Sensor.
The solder contact time between the chip and solder wave for the C sensor must be
greater than 1.0 seconds to be counted as separate wave contacts. If less than 1.0
seconds, the multiple solder contacts are considered “noise” or contact bounce and are
counted as one wave contact rather than two.
In addition, as the distance between the chip and solder wave gets larger, the time
between the C sensor leaving the solder wave and the Speed sensor hitting the chip
wave must also be less the 1.0 seconds. If not, these two solder contacts will be seen
as one wave for the same reasons stated above.
Figure C- 3 illustrates the interaction between the two waves and the WaveRIDER
pallet sensors as described above.

Speed Sensor

Chip to Solder Wave Separation
Travel time between waves must be
greater than 1.0 seconds.

C to Speed Sensor Separation
Travel time between C just exiting the solder
wave and Speed sensor entering chip wave
must be greater than 1.0 seconds.

Solder Wave
Contact Length

C Sensor just exits the
Solder Wave

Figure C- 3: Chip/Solder Wave vs. WaveRIDER Pallet Sensors
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The graph shown in Figure C- 4 should be used to determine the maximum conveyor
speed you may use to avoid violating the 1.0 second minimum travel time between
sensors and waves. This is a function of the distance between the chip and solder
waves and the average solder wave contact length.
Maxium Conveyor Speed vs Contact Length
Dropout Filter time = 1.0 Sec
Average Contact Length (in)
3.5"

20

3.0"

2.5"

2.0"

1.5"

1.0"

0.5"

19
18
17
16

Maximum Conveyor Speed (ft/min)

15
14
13
12
11
10
9
8
7
6
5
4
3
2
1
0
0.0

1.0

2.0

3.0

4.0

5.0

6.0

7.0

8.0

Wave Seperation (in)

Figure C- 4: Dropout Time Graph

Locate the curve that represents your average contact length. Locate the Chip to Solder
wave separation on the X-axis of the graph. Move up vertically until it intersects the
contact length or the fixed curve. Look to the left to determine the maximum conveyor
speed you may run.
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COUPON TEMPERATURE STATISTICS
For all three coupon T/C’s, the following is recorded:
(exception: solder sensor slopes are not calculated since they are normally very fast).
Min°: Lowest temperature seen throughout the data set.
Max°: Highest temperature seen throughout the data set.
Max (-) Slope: Greatest negative (falling) temperature change seen throughout the data
set.
Max (+) Slope: Greatest positive (rising) temperature change seen throughout the data
set.
Slope is measured over a 1 second time interval using a “linear regression”
technique (m = Slope).

Time > 361°F (183°C) = The total time spent above the typical solder melting point.
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APPENDIX D: WR SPC Parameter Definitions
Value tab

C1, C2, C3, C4 indicate the point, time relative, time absolute, or distance (depending
on the Units setting) on the X axis where the vertical cursors are set, respectively. The
values below are the measured values for each channel at that position.
Time to Reference tab

Low, Medium, and Hi are the temperatures set in the Temp Ref Lines dialog, if set.
The values below these are the times in hours, minutes, and seconds (hh:mm:ss) that it
takes for each channel to reach the respective reference value starting from the
process origin.
Time Above Reference tab

Values shown in this tab are taken from the graph at it’s present level of magnification.
X-axis values outside of view are not included in the calculations. Y-axis values,
however are included regardless of magnification level.
Low, Medium, and Hi are the temperatures set in the Temp Ref Lines dialog, if set.
The values below these are the times in hours, minutes, and seconds (hh:mm:ss) that
each channel spent at or above the reference value, if at all. All time above the
reference values are accumulated in the total no matter where they occur.
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Cure Factor%. The cure factor % is based on the time a sensor temperature was above
a temperature reference line divided by the time you entered in the Times Above Temp
(TAT) section of the Temp Ref Lines dialog box. This equation gets more complicated
as you add more temperature reference lines. The graph illustrates the times used
(shaded area) to sum the total curing time each temperature threshold contributes.
The following equation is used when all three temperature reference lines are used:
Cure Factor % = 100 * ( HItime/HItat + (MEDtime – HItime) /MEDtat + (LOtime – MEDtime)/LOtat )

The same basic equation is used when there are only two (any two) temperature
reference lines used:
Cure Factor % = 100 * ( HItime/HItat + (MEDtime – HItime) /MEDtat )

or
Cure Factor % = 100 * ( MEDtime/MEDtat + (LOtime – MEDtime) /LOtat )

or
Cure Factor % = 100 * ( HItime/HItat + (LOtime – HItime) /LOtat )

Finally, if only one temperature reference line is used, the equation is simply:
Cure Factor % = 100 * time/tat (which ever temp ref line you are using)\

LO Time
MED Time
HI Time
HIref
MEDref
LOref
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Statistics tab

Values shown in this tab are taken from the graph at it’s present level of magnification.
X-axis values outside of view are not included in the calculations. Y-axis values,
however are included regardless of magnification level.
Minimum is the lowest value measured. The values below are the minimum values for
each channel.
Minimum X is the point in time where the minimum value occurred. The values below
are the first point on the X-axis where the minimum value occurred for each channel.
Maximum is the highest value measured. The values below are the maximum values
for each channel.
Maximum X is the point in time where the maximum value occurred. The values below
are the first point on the X-axis where the maximum value occurred for each channel.
Average is based on the following equation:
Σx/n
Where n is the number of data points and x is the value of any given data point. The
values below are the average values for each channel.
Standard Deviation is based on the following equation:
√(n ⋅ Σx2−(Σx) 2)/n ⋅
Where n is the number of data points and x is the value of any given data point. The
values below are the standard deviation values for each channel. Small standard
deviation means the data is used to calculate it is well centered around the average of
that same data.
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Summary Statistics tab

Values shown in this tab are taken from the intire graph regardless of its level of
magnification.
Peak Temperature is the largest measured value. Values below are the largest value
recorded for that channel. The higher the peak temperature, the greater the possibility
for component damage.
PEAK TEMP

Figure D- 1: Peak Temp
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Minimum Temperature is the smallest measured value. Values below are the smallest
value recorded for that channel. Typically, these are the starting values, unless there is
active cooling employed. It is best if starting temperature values are close to the same.
This will allow a consistent starting point for other measurements.

MINIMUM TEMP

Figure D- 2: Minimum Temp

♦172♦

WaveRIDER

Maximum (+) Slope is the largest positive slope measured using a 2% of the total
points in the Profile length (x-axis) differential. Thus, the equation for slope calculation
is as follows:
Slope at point X = (Value at point (X + 10) – Value at point X) / (10 * Log interval in
seconds)
MAX (+) SLOPE

Figure D- 3: Max (+) Slope

The values below are the largest positive slope values calculated for each channel. The
larger the slope, the faster the temperature is increasing (heating).
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Maximum (-) Slope is the largest negative slope measured using a 2% of the total
points in the Profile length (x-axis) differential. Thus, the equation for slope calculation
is as follows:
Slope at point n = (Value at point (n + 10) – Value at point n) / (10 * Log interval in
seconds)

MAX (-)
SLOPE

Figure D- 4: Max (-) Slope

The values below are the largest negative slope values calculated for each channel.
The larger the slope, the faster the temperature is falling (cooling).
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Time above Temperature is the total time spent at or above the selected temperature
in seconds. This time above may occur anywhere along the x-axis and all will be
accumulated in the total time. Values below are the total times spent at or above for
each channel. The longer the time, the longer typical solder will be in its liquid state.
TIME ABOVE TEMPERATURE

Figure D- 5: Time above 183C
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Time between Temperatures is the time required for the temperature to rise from the
begin temperature to the end temperature. The values below are the times in seconds
measured for each channel. The larger this value, the longer it takes to heat the given
temperature sense point.
TIME BETWEEN TEMPERATURES

Figure B-1: Time 150C - 180C
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Time above Temperature / Peak Slope is the Slope between the point where the
profile rise above the Temperature and the Profiles Peak temperature.
TIME ABOVE TEMP / PEAK SLOPE

Figure B-2: Time Above Temp / Peak Slope
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Peak Slope / Time above Temperature is the Slope between the point where the
profile drops below the Temperature and the Profiles Peak temperature.
PEAK / TIME ABOVE TEMP

Figure B-3: Peak Slope / Time Above Temp
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KPI tab

Values shown in this tab are set by the user.
● Temperature Parameters:
Peak Temperature is the largest measured value. Values below are the largest value
recorded for that channel. The higher the peak temperature, the greater the possibility
for component damage.
Min Temperature is the smallest measured value. Values below are the smallest value
recorded for that channel. Typically, these are the starting values, unless there is active
cooling employed. It is best if starting temperature values are close to the same. This
will allow a consistent starting point for other measurements.
Max Slope (+) is the largest slope measured using the seconds specified in the user
configured calculate slope value text box. This column then displays slopes in the
positive direction.
Max Slope (-) is the largest slope measured using the seconds specified in the user
configured calculate slope value text box. This column then displays slopes in the
negative direction.
Max Slope (+ or -) is the largest slope measured using the seconds specified in the
user configured calculate slope value text box. This column then displays the larges
slope in the positive or negative direction depending on which is larger.
● X Cursor Parameter Data:
C1, C2, C3, C4 indicate the point, time relative, time absolute, or distance (depending
on the Units setting) on the X axis where the vertical cursors are set, respectively. The
values below are the measured values for each channel at that position.
Slope between Cursor locations is the straight line slope between any two cursors.
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● Time Parameter Data:
Time To Temperature is the time that it takes for each channel to reach the selected
value in seconds or minutes.
Time above Temperature is the total time spent at or above the selected temperature
in seconds or minutes.
Total (+/-): Total Time above temperature.
Rising (+): Time above during the rising portion of the temperature Profile.
Falling (-): Time above during the falling portion of the temperature Profile.
Time between Temperatures is the time required for the temperature to rise from the
begin temperature to the end temperature in seconds or minutes.
Slope between Temperatures is the straight line slope measured between the
beginning and ending temperatures.
● Display Values:
Range is the difference between the largest and smallest value recorded or calculated
for each column of data. The smaller the range, the smaller the spread between the
values collected from each channel.
Average is the calculation of the average value for each column displayed.
Standard Deviation is the calculation of the Standard Deviation for each column
displayed.
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APPENDIX E: WaveRIDER Accuracy and the Influencing Factors
There are two fundamental measurements the WaveRIDER measures: temperature
and time. The accuracy, resolution and range the WaveRIDER is capable of is stated in
the Specification section of the manual. The purpose of this paper is to show how these
specifications affect the solder machine parameters presented on the WaveRIDER
printout.
Time Specifications
Measurement time by the WaveRIDER is influenced more by the log rate rather then
the overall accuracy of the timer. The WaveRIDER takes data at a log rate of 0.1sec.
Thus every reading of time has a tolerance of ±0.1 second. The net effect on time
dependent variables is best illustrated on the graphs below.
Dwell Times
The % effect that ±0.1 seconds has on the measured dwell times decreases as the
dwell time increases. To determine the maximum error of dwell time measurements,
locate the measured dwell time on the X axis of the graph and run vertically to the
curve. Now run horizontally to the left and find the % error on the Y axis. Clearly the
maximum % error that 0.1 seconds has on the measured value increases dramatically
as your dwell times approach 0.1 seconds (100% error!), but practical dwell times run
from 2 to 5 seconds or 5% to 2% error respectively.
Conveyor Speed
The % effect that ±0.1 seconds has on the measured conveyor speed increases with
the actual conveyor speed. To determine the maximum error of conveyor speed
measurements, locate the measured speed (ft/min) on the X axis of the graph and run
vertically to the curve. Now run horizontally to the left and find the % error on the Y axis.
This is the maximum % error of actual conveyor speed you could expect to see. Typical
errors run at about 0.75% at 4ft/min.
Time measurement can be altered if there is one or more open T/C(s) on the
coupon.
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Contact Lengths
Contact length is the product of conveyor speed and dwell time. Thus the % errors of
both must be added to determine the total maximum % error for contact length. To
determine the maximum error of contact length measurements, locate the measured
dwell time on the X axis of the graph and run vertically to the curve that is closest to the
measure of conveyor speed. Now run horizontally to the left and find the % error on the
Y axis. As you can see from this graph, conveyor speed has little effect on error as the
dwell times get much below 2 seconds. Typical errors range from 4% to 6% of the
actual dwell time depending on the conveyor speed and the dwell time.
Temperature Specifications
Absolute temperature accuracy is dependent on four basic factors:
1) The accuracy of the thermocouple sensor (T/C)
2) The accuracy of the Cold Junction Compensation sensor (CJC)
3) The accuracy of the overall Analog to Digital system (A/D)
4) The conformity to the International Practical Temperature Scale (IPTS)
Other factors could be mentioned here but they are either too small to be concerned
with or are “lumped” in with those mentioned above.
The maximum possible error for a given temperature reading is the sum of the errors
listed above. For the Wave Rider this maximum would be:
T/C ± 4°F + CJC ± 4.5°F + A/D ± 0.3°F + IPTS ± 0.1°F = ±8.9°F
This may seem extreme but it is the theoretical maximum error (see Specification in the
WaveRIDER manual). However, we calibrate each WaveRIDER to ±1.8°F (1°C) at
212°F (100°C) and 1832°F (1000°C). With conformity to IPTS at 0.1°F and A/D error at
0.3°F, the practical maximum error would be (when using a traceable voltage standards
as the calibration source):
± 1.8°F + IPTS ± 0.1°F + A/D ± 0.3°F = ±2.2°F
This leaves only the T/C error to deal with. The WaveRIDER uses “Standard Limits of
Error” T/Cs which have ±4°F tolerance. Practical use of these standard T/Cs shows that
these tolerance limits are rarely approached. Tighter tolerance T/Cs can be used at
extreme cost, with a tolerance no better then ±2°F. This small gain in accuracy is not
worth the extra cost, considering the temperature range being measured by the
WaveRIDER (<500°F typically).
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Figure C-5: Conveyor Speed Error
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Figure C-6: Dwell Time Error
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Figure C-7: Contact Length Error
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Solder Wave Variation
Solder wave variation happens. It is by nature a dynamic process caused by the
pumping of a liquid. Through various channels, weirs, rudders, and nozzles, all
designed to balance flow across the surface of the wave, liquid solder makes its way to
the surface and finally breaks one way or the other depending on the wave shape.
Lacking the presence of a printed circuit board, this wave looks even and more or less
smooth on typical wave solder machines. However, some ripples and eddies are visible
as the flow of solder moves toward the spill point. These ripples are everywhere and
only some of the bigger ones are pointed out in the picture below.

Typical Ripples and Currents that appear on otherwise smooth looking waves

Figure C-8: Solder Wave Ripples

Currents running throughout the wave take on a whole new manifestation when they
run into the underside of a printed circuit board. They will cause the crest of the wave to
vary, much like ocean waves as run up a sandy beach. An ocean wave will never rush
up the sand and stop in a perfectly straight line even though the beach may be very flat.
Thus the crest of the solder wave, as it flows against the underside of a printed circuit
board, will be very dynamic. You can view this using a tempered glass plate, such as
the one called “Lev Cheek” by Hexacon Electric, as it runs slowly across the solder
wave just like you would solder a printed circuit board. A typical solder wave using this
glass plate is pictured below.
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A

B

C

Direction of Conveyor

Typical wave crest pattern as viewed through a tempered glass plate

Figure C-9: Typical Wave Crest

The crest of the wave is highlighted to make is more visible. As you can see, the edge
is very rough and is constantly changing shape as it progress across the board. It is
also noticed that the sides of the wave tend to be narrower then the middle. Based on
this snap-shot, one would expect this wave to read parallel with sensors “A” and “C”
reading lower contact times then “B.” This high in the middle observation is typical in
many waves and is not because the glass bent down in the middle. It is most likely due
to increased pumping action near the center of the wave, which may also be causing
the increased ripple action near the center as seen in the first wave illustration. Also,
with this typical wave dynamics one should expect successive measurements to have
some variation. In the above illustration, at 4 ft/min conveyor speed, one can expect up
to 0.8 seconds variation from sensor to sensor.
The real issue in making exact measurements from your solder wave is to determine
what your solder process can tolerate, and not so much to make the solder processes
perfect. Clearly some parameters are more important such as conveyor speed, solder
temperature, and preheat slopes, but to expect a pumped liquid as dense as solder to
behave with perfect geometry is asking a bit much from the machine manufacture. If
your solder process is not producing good results, a measurement tool will quickly point
out the problem. But the goal of measuring a good process over and over is to obtain
data which can be used to determine how much variation is acceptable and help predict
when a good process is going bad.
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APPENDIX F: Pull-Down Menus & Toolbar Buttons
The dimmed menu commands are used in other worksheets.
Active menus for the Welcome & Guide Worksheets:

Active menus for the WaveRIDER Worksheet:

Active menus for the Spreadsheet Worksheet:
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Active menus for the Profile Worksheet:

Active menus for the Administration Worksheet:

Active menus for the SPC Worksheets:
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Tool buttons:
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3d View

Open

About

Overlay

Align Left

Peak Difference

Align Right

Prediction

Back (To Previous Data Run)

Print

Bold

Redo

Center

Read WaveRIDER Data

Copy

Save

Erase All

Slope

Erase Objects

Tolerance Band

First (Data Run)

Total Heat

Italic

Underline

Last (Data Run)

Undo

Magnify

WaveRIDER Settings

New

Zoom 100%

Next (Data Run Difference

Zoom In

Notes

Zoom Out
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APPENDIX G: WaveRIDER Accessories
ITEM

PART NUMBER

Test Coupons:
Test Coupon, Double sided, 2.5” (63 mm) wide (No-Lead)
E44-9283-64
Test Coupon, Double sided, 2.5” (63 mm) wide (No-Lead) (3 pk) E44-9283-14
Manuals & Software:
WaveRIDER Users Guide
Expert Guide to Wave Soldering
WaveRIDER SPC Software CD

A36-9283-00
A36-9283-06
Y50-9283-40

Miscellaneous:
SuperM.O.L.E. Gold to PC Interface Cable
USB/RS-232 Serial Adapter
Extended warranty, 1 year. Includes 1 calibration

Y20-2848-04
Y23-7782-10
A10-0900-00
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